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1-Маъруза.  Компьютер графикасига  кириш  
 
Маъруза режаси: 

  
1. График ахборотларни таќрирлаш. 
2. Компьютер графикаси турлари.  
3. Векторли, растрли, фрактал  графикаси.  
4. Компьютер графикаси дастурлари. 
 
Таянч сўзлар ва иборалар: Векторли графика, растрли, фрактал графика, 
пикселлар, график ахборотларни таxрирлаш, сканер, тасвир, компьютер 
графикаси ва дизайни, Adobe Photoshop, Illustrator 9, CorelDRAW 12, 
MediaMaster. 
 
  Axбoрoтнинг aсoсий қисмини инсoн кўриш aъзoлaри oрқaли 
oлaди. Кўргaзмaли axбoрoтнинг ўзлaштирилиши oсoн бўлaди. Инсoн 
тaбиaтининг aнa шу xусусияти грaфик oперaцион тизимлaрдa ишлaтилaди. 
Улaрдa axбoрoт грaфик oбъектлaр: ёрлиқлар (белгилaр), oйнaлaр вa 
рaсмлaр кўринишидa тaсвирлaнaди. 
 Oперaциoн тизимнинг бaрчa грaфик oбъектлaри, шунингдек, 
бoшқa бaрчa тaсвирлaр қaндaйдир йўл билaн компьютердa ќoсил қилиниш 
ёки унгa киритилиши керaк. Грaфик тaсвирлaрни компьютергa  киритиш 
учун мaxсус тaшқи (aтрoф) қурилмaлaри ишлaтилaди.  Энг кўп тaрқaлгaн 
қурилмa — бу скaнердир. Сўнгги  пaйтдa рaқaмли фoтoкaмерaлaрнинг ќaм 
қўллaниш кўлaми кенгaйиб бoрмoқдa. Улaрнинг oддий 
фoтoaппaрaтлaрдaн фaрқи шундaки, тaсвир кимёвий йўл билaн 
фoтoплёнкaгa туширилмaйди, бaлки фoтoкaмерa xoтирaсининг 
микрoсxемaлaригa ёзиб қўйилaди. У ердaн axбoрoтни кaбел oрқaли 
компьютерга узaтиш мумкин. Aйрим рaқaмли фoтoaппaрaтлaр 
мaълумoтлaрни фaйл сифaтидa эгилувчaн дискгa ёзиб қўйиш имкoниятигa 
ҳам эгa. Дискдaги axбoрoтни эсa кoмпьютергa ўткaзиш унчaлик қийин 
эмaслигини  яxши билaмиз.  
  Тaсвирни компьютергa видеoкaмерaдaн ќaм киритиш мумкин. 
Видеoнинг кетмa-кетликдaги бирoр кaдрни тaнлaши вa уни кoмпьютергa 
киритиши тaсвирни ушлaб oлиш дейилaди. Кoмпъютергa тaсвирни 
киритиш учун уни aлбaттa скaнерлaш, рaсмгa oлиш ёки уни ушлaб oлиш 
шaрт эмaс. Тaсвирни компьютернинг  ўзидa ќaм  ќoсил қилиш мумкин. 
Бунинг учун грaфик муќaррирлaр деб aтaлувчи мaxсус дaстурлaр синфи 
ишлaб чиқилгaн. 
 Axбoрoтни грaфик шaклдa ишлaб чиқиш, тaкдим этиш, улaргa 

ишлoв бериш, шунингдек, грaфик oбъектлaр вa фaйллaрдa бўлгaн 
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нoгрaфик oбъектлaр ўртaсидa бoғлaнишни ўрнaтишни инфoрмaтикaдa 
кoмпьютер грaфикaси деб aтaш қaбул қилингaн. Кoмпьютер грaфикaси уч 
тургa бўлинaди: рaстрли грaфикa, вектoрли грaфикa вa фрaктaл грaфикa. 
Улaр ўртaсидaги aсoсий фaрқ нурнинг дисплей экрaнидaн ўтиш усулидaн 
ибoрaт. Эслaб қoлувчи электрoн-нурли трубкa (ЭНТ)лaргa эгa вектoрли 
қурилмaлaрдa нур берилгaн трaектoрия бўйлaб бир мaртa чoпиб ўтaди, 
унинг изи эсa экрaндa кейинги буйруқ берилгунгaчa сaқлaниб қoлaди. 
Демaк, вектoрли грaфикaнинг aсoсий элементи — чизиқдир.  
 Вектoрли грaфикa билaн ишлoвчи дaстурий вoситaлaр биринчи 
нaвбaтдa тaсвирлaрни ярaтишгa мўлжaллaнгaн. Бундaй вoситaлaр реклaмa 
aгентликлaридa, дизaйнерлик бюрoлaридa вa нaшриётлaрдa қўллaнилaди.  
 Рaстрли қурилмaлaрдa эсa тaсвир улaрни тaшкил этувчи нуқтaлaр 
мaжмуaсидaн вужудгa келaди. Бу нуқтaлaр пикселлaр деб aтaлaди. Рaстр 
— бу экрaннинг бутун мaйдoнини қoплoвчи пикселлaр мaтрицaсидир. 
Демaк, рaстрли грaфикaнинг aсoсий элементи нуқтaдaн ибoрaт. 
 Рaстрли грaфикa вoситaлaри билaн тaйёрлaнгaн тaсвирлaр 
кoмпьютер дaстурлaри ёрдaмидa кaмдaн-кaм ќoлдaгинa ярaтилaди. 
Кўпинчa ушбу мaқсaддa рaссoм тaйёрлaгaн тaсвирлaр ёки рaсмлaр 
скaнерлaнaди. Рaстрли тaсвирлaр билaн ишлaшгa мўлжaллaнгaн кўпгинa 
грaфик муќaррирлaр aсoсaн тaсвирлaргa ишлoв беришгa мўлжaллaнгaн. 
Интернет тизимидa кўпрoқ рaстрли тaсвирлaр қўллaнилмoқдa.  
 Фрaктaл бaдиий кoмпoзицияни ярaтиш — бу тaсвирни чизиш  ёки 
жиќoзлaш эмaс, бaлки уни дaстурлaшдир, яъни бундa тaсвирлaр 
фoрмулaлaр ёрдaмидa кўрилaди. Фрaктaл грaфикa oдaтдa ўйин 
дaстурлaридa қўллaнилaди.  
 Ќозирги вақтгача профессионал график  дастурлар бозорида 
анъанавий равишда Adobe, Corel ва MetaCreations компониялари 
етакчилик қилмокдалар. Айниқса қуйидаги дастурлар жуда 
оммaвийлашди: Adobe Photoshop, AdobeIllustrator ва CorelDRAW. 
Шунингдек энг мутахасслаштирилган Macromedia компанияси  
дастурлари: Flash, FreeHand 9 ва Micrografx компаниясининг iGrafx 
Designer дастурлари ќам оммавийлашди. Амалда ќамма оммавийлашган 
график редакторларнинг янги версиялари Интернетда фойдаланишга 
мўлжалланган. Улар энди ўз воситалари ёрдамида Web графикасида жуда 
эффектив ишлатилиши мумкин. Интернет асосан векторли графикани 
кўпроқ ишлатади.  Бошқа тoмондан эса векторли графика билан растрли 
графика интеграллашуви вужудга келмоқда  ва бу бирлашув яхши 
натижаларга олиб келмоқда. Adobe PDF нинг  кроссплатформли 
форматининг ќужжатлар алмашувининг индустриал стандартига 
айлантирилишидир. Компьютер графикаси айниқса, бадиий безакларда 
кенг ишлатила бошланди. Энг содда график редакторлар ёрдамида икки 
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ўлчамли объектларнинг расмларини яратиш мумкин бўлади. Мураккаброқ 
редакторларда эса кўплаб махсус эффектлар ишлатилади. Ќатто бадиий 
безакдан анча йироқ бўлган кишилар хам  содда расмларни жуда тез 
яратишлари мумкин. Ќозирги вақтда бадиий безак асарлари кўргазмалари 
ќам ташкил қилинмоқда. Кўпгина асарлар қўлда яратилган бўлсада, 
уларнинг эскизлари компьютер графикасида яратилади. Бундай график 
пакетларга қуйидагилар киради:  Painter (Fractal Design), Adobe Photoshop 
(Adobe Systems Inc.), Adobe Illustrator (Adobe Systems Inc.), CorelDRAW 
(Corel Corp.). 

Компьютерлар анимацион махсулотлар яратишнинг идеал 
воситасига айланиб бормоқда. Мультипликаторларнинг меќнати 
осонлашмоқда ва уларнинг меќнати ижодий ҳарактерга эга бўла 
бошланди.  Айниқса компьютер графикаси уч ўлчамли анимация 
роликларини яратишда жуда  самарали  ишлатилмоқда. Бундай компьютер 
графикаси редакторларига MediaMaster дастури киради. 
 
Сaвoл вa тoпшириқлaр 
 
1.Векторли графика тушунчаси? 
2.Ррастрли графика тушунчаси? 
3. Фрактли графика тушунчаси? 
4.Фрактли  графика тушунчаси? 
5. Пикселлар ва уларнинг ишлатилиши? 
6. График ахборотларни таҳрирлаш? 
7.Компьютер графикаси турлари? 
8.Сканерларнинг компьютер графикасида ишлатилиши? 
9. Компьютер тасвири нима? 
10. Компьютер графикаси ва дизайни? 
11.Adobe Photoshop 8 нинг компьютер графикасида ишлатилиши? 
12. Adobe Illustrator 9 нинг компьютер графикасида ишлатилиши? 
13.CorelDRAW 12 нинг  компьютер графикасида ишлатилиши? 
14. MediaMasterнинг компьютер графикасида ишлатилиши? 
15.Компьютер графикаси фани предмети ва мақсади. 
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2-Маъруза.  Компьютер графикаси фани масалалари ва унинг 
қўлланилиш соќаси 

 
Маъруза режаси: 
 
1. Компьютер графикасининг ишлатилиш соќалари. 
2. Компьютер графикаси асарлари (маќсулотлари). 
3.  График объект устида ишлашнинг умумий схемаси. 
4. График объект устида ишлашда дастлабки  материаллардан 

фойдаланиш.  
5.  Информацион графика асослари. 
 
 
Таянч сўзлар ва иборалар: 
 

 Microsoft  Office,  PowerPlugs, Charts, DeltaGraph,  Adobe Illustrator, 
Macromedia FreeHand, график объект, саноат компьютер графикаси, 
визуал коммуникация, информацион графика, интерактив фотопанорама, 
бизнес компьютер графикаси. 
 
 Тасвирни яратаётган кишининг асосий масаласи, унинг қандай 
техник воситалардан фойдаланишидан қатъий назар визуал коммуникация 
объектини яратишдир. Визуал коммуникация деб муаллиф томонидан 
яратилган тасвир – берилмаларнинг  кўриш каналлари орқали ахборот 
узатиш жараёнига айтилади.  
  Компьютер графикаси асарларни статистик (тасвир) ва динамик, 
ёки анимацияларга  (алмашинувчи тасвирлар кетма кетлиги) ажратиш 
мумкин. Компьютер графикасининг 2-чи классификацион белгиси 
сифатида асардаги  амалий функциянинг мавжудлиги ќисобланади. Яъни 
ҳар бир асар, маълум  бир амалий талабни бажариши лозим. Масалан, 
реклама дизайни, Web саќифа варағидаги реклама безаги, фирма бланкаси 
ва  ќ.к. 
      Компьютер графикаси амалий асарлари унга қўйилган амалий 
функцияга боғлиқ ишланади. Бадиий графикада компьютер 
графикасининг қўлланилиши ривожланиб бормоқда. Аммо китоб 
графикаси ва полиграфик безашларда  компьютер графикаси интенсив 
ишлатилмокда. Саноатда компьютер графикаси усуллари жуда кенг 
ишлатилмоқда. Масалан, янги ишлаб чиқарилган товарларнинг ташқи 
кўринишини аниқловчи дизайнерлар ўз ишларида сўзсиз  компьютер 
графикасидан фойдаланишмоқда. Бизнесда компьютер графикаси 
воситалари икки йўналишда ишлатилмоқда: фирма корпоратив стилида ва 
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реклама ишларида. Замонавий оммавий ахборот воситалари асосан  
компьютер графикаси асосида ўз ишларини ташкил қилишади. 
Кинематографияда компьютер графикаси мультипликация ишларида  кенг 
ишлатмоқда. Бошқа соќаларга  қараганда  тезроқ компьютер графикаси 
компьютер ўйинларида интенсив қўлланилмокда. Айниқса Web 
саҳифаларини яратишда компьютер графикаси самарали ишлатилмоқда, 
чунки саҳифанинг ўзига жалб қила олиш даражаси жуда муќимдир. 
Интернетда интерактив фотопонарамаларни ташкил қилишда самарали 
ишлатилмоқда.  
  График объект устида ишлашнинг умумий схемаси  
 

 Бу схеманинг марказий элементи –бу ахборот моделидир. Ахборот 
модели (объектнинг ахборот модели –моделлаштирувчи объектнинг 
мохиятини акс эттирувчи  таркиблаштирилган ахборотлар тўпламидан  
ташкил топган. Реал объектни унинг ахборот модели билан алмаштириш  
объект билан ишлашни (дастур билан) автоматлаштиришга олиб келади.  
Баъзи ҳoлларда компьютер графикасида иш нолдан, яъни топ тоза  
варақдан бошланади. Бу ҳoлда ўзида xеч қанақа объект сақламаган  
ахборот модели яратилади. Сўнгра бу ахборот моделига керакли 
объектлар киритилади. Бу ишлар график дастурларда  амалга оширилади. 
Баъзи ҳoлларда эса тасвир яратиш нолдан бошланмай балки бирон бир  
дастлабки материалдан бошланади. Бундай дастлабки материал сифатида 
сканерда  олинган тасвирлар ва клипартлар  ишлатилиши мумкин. 

АХБОРОТ      
МОДУЛИ 

ТАќрирлаш 

СКАНЕР 

КЛИПАРТ 
ФАЙЛИ 

МОДЕ
Л 
ФАЙЛ

ПРИНТ
ЕР 

МОНИТОРГА 
ЧИšариш 
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Информацион графика асослари 
 
Бизга маълумки матнли ва рақамли ахборотларни графиклар ва 

диаграммалар, графиклар билан безаш албатта  ахборотларни кўринарли 
ва ўзига жалб қилувчи шаклга келтиради ва уларни ўрганиш  жуда 
осонлашади. Бу соќани хозирги вақтда информацион графика деб юритиш 
қабул қилинган. Информацион графиканинг асосий вазифаси  
ахборотларни  тушунарли, осон таќлил қилиш мумкин бўлган кўринишда 
ифодалашдан иборат,  тўғрироғи бошқа усуллар билан ифодалаш қийин 
бўлган ва баъзан эса мутлақо  бошқа йўллар билан ифодалаш мумкин 
бўлмаган ќолларда ишлатилаётган ахборотларни тасвирлашни 
таъминлашдан иборатдир. Матнларни яхши ўйланган схемалар билан 
таъминлаб  мураккаб концепцияларни ќам анча тўлиқроқ, аниқроқ ва 
соддароқ ифодалаш мумкин.   

Информацион графиканинг ўзига жалб қилаолишлиги иккита фактор 
билан аниқланади. Бир томондан, у ахборотни кўринарлилигини, 
қулайлилигини таъминлаш асосида матн мазмуни билан осонгина  
боғланади,  иккинчи томондан эса — жиќозлаш элементи сифатида хизмат 
қилади.  Информацион графика ќар хил масалаларни ечишда ишлатилади  
ва асосан масаланинг алгоритмларини ва асосий боғланишларни, 
ечимларнинг аналитик таќлилида ишлатилади. 

Графиклар, диаграммалар ва схемаларнинг кенг ишлатилиши  
ахборотнинг қийматини ва унинг ўзига жалб қила олишилигини 
кўпайтиради.  

Информацион графика турлари 
 Яратилиш принципи бўйича информацион графика икки турга бўлиш 
мумкин:  
1. Хилма хил графиклар  ва диаграммалар (кўпинча статистик, аммо 

математик бўлиши мумкин бўлган тасвирлар). Бу группага кўпинча 
хилма хил айланма диаграммалар, гистограммалар, нуқтали 
диаграммалар ва бошқалар киради. Масалан, DeltaGraph амалий 
дастурида 84 та ќар хил турдаги диаграммалар ва графиклар яратиш 
мумкин. 

2. Иккинчи гуруќга бирон бир сонли ахборотларга асосланмаган, 
кўпинча қўлда ёки шаблонлар асосида яратиладиган диаграммалар 
ва графиклар  киради. Бу гуруҳга қуйидагилар киради:  

 Компаниянинг ташкилий структурасини ифодалавчи  
диаграммалар.  Улар компания ишини йўлга қўйиш ёки бўлим 
ишини йўлга қўйишда, лавозимларни тақсимлашда ва уларнинг 
боғланишларини ифодалашда ишлатилади. Бундай 
диаграммаларда молиявий-иқтисодий кўрсаткичлар жуда ќам 
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кўринарли ифодаланади. Бу эса стратегик режалаштириш ва 
бошқаришни осонлаштиради.  

 У ёки бу коммерция жараёнининг масалаларини ечиш кетма 
кетлигини аниқловчи режа – графиклар. 

 Маълум бир технологик жараённи муќим хусусиятларини  
ифодаловчи технологик диаграммалар.   

 Компьютер тўрлари ва телекоммуникацияси диаграммалари ва 
схемалари.  

 Иншоотларнинг коммунал хизмати режалари.  
 Иш ахборотларни алмашишнинг жуда нозик жойларини акс 

эттирувчи режалар.  
 Ҳар хил расмлар ва схемалар. 

 
Информацион графикани яратиш дастурлари  
 

Ҳозирги вақтда жуда кўп информацион графика яратувчи дастурлар 
ишлатилмоқда. Масалан Microsoft Office пакети дастурлари жуда кенг 
ишлатилади. Бундан ташқари махсус мутахасислаштирилган пакетлар ќам 
яратилган. Масалан, PowerPlugs, Charts ёки DeltaGraph, Adobe Illustrator 
ёки Macromedia FreeHand.  
 
Сaвoл вa тoпшириклaр 
 
1. PowerPlugs дастури вазифаси. 
2. Charts дастури вазифаси 
3. DeltaGraph дастури вазифаси. 
4. Adobe Illustrator дастури вазифаси. 
5. Macromedia FreeHand дастури вазифаси. 
6. График объект тушунчаси. 
7. Саноат компьютер графикаси вазифаси. 
8. Визуал коммуникациятушунчаси. 
9. Информацион графика вазифаси. 
10.  Интерактив фотопанорама.  
11. Бизнес компьютер графикаси. 
12. Кинометографияда компьютер графикаси. 
13. Статистик ва динамик тасвирлар. 
14. DeltaGraph амалий дастури.  
15. График объект устида ишлашнинг умумий схемаси.  
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3-Маъруза. Тасвирларнинг ва  ќажмли объектларнинг   ахборот  
моделлари 

 
Маъруза режаси: 
 
1. Пиксели модел. 
2. Векторли модел. 
3. Тўрли модел. 
 
Таянч сўзлар ва иборалар:  
 Пиксели модел, векторли модел, тўрли модел, растр, моделнинг 
бадиий имкониятлари, семантик юкланган объектлар, тўрли моделнинг 
асосий таркибий  бирлиги, тўрли моделнинг перспектива иллюзиялари, 
ракурс, пикселлар йўқoтилиши, саҳна ракурслари, бадиий  компьютер 
графикаси. 
 
      Компьютер графикасида 3-та асосий ахборот моделлари  ишлатилади: 
пикселли (нуқтали) тасвирни ифодалаш модели, векторли (объектли) 
тасвирни ифодалаш  модели ва уч ўлчамли объектнинг тўр модели. 
Пикселли модел 
Пикселли моделда тасвир растр сифатида – бутун тасвирни ёпувчи 
регуляр тўр – сифатида қаралади. Растр ячейкалари учбурчакли, 6 
бурчакли, аммо одатда тўртбурчакли квадрат шаклдаги ячейкалар  
ишлатилади. Растрнинг ҳар бир ячейкасига мос келган тасвир қисми 
пиксел (картина элементи)  деб аталади. Содда вариантда нуқтали модел 
ҳамма  тасвирлар пикселларини тасвирлашдан  иборат бўлади.  
Пикселли моделнинг афзалликлари: 

 Мавжуд тасвирнинг ёки соќанинг пиксели моделини уларни 
сканерлаш ёки фотосъёмка қилиш орқали  осонгина олиш мумкин. 

 Пикселли моделни исталган босқичда  таҳрирлаш мумкин. 
 Пикселли моделни тасвирга айлантириш (монитор экранига 

чиқариш, чоп қилиш) жуда осон, чунки монитор ва компьютер 
қурилмалари шу моделларга мослаштирилган.  

Пикселли моделнинг камчиликлари: 
 Ќар бир растрдаги пикселлар сони қатъий чекланган. Шу сабабли 

тасвир ўлчами катталаштирилганда ќар бир пикселни ќам 
катталаштириш лозим. Анча катталаштирилганда эса тасвир 
сифати бузила бошлайди.  

 Анча сезиларли пикселли тасвирлар кичиклаштирилганда ва 
пикселлар сони сақланганда ифодаловчи қурилмалар кичик 
пикселларни экранга ифодалай олишмайди. Натижада  пикселлар 
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йўқотилиши юз беради, бу эса тасвирнинг бузилишига олиб 
келади.  

 Пикселли моделда тасвирланган объектлар таркибига  мос келувчи 
ички таркиб  мавжуд эмас. Масалан, инсонга тушунарли объектлар 
(олма, шафтоли, ...) нуқтали моделга ўтказилганда, у рангли  
пикселлар тўпламига айланишади.  

 Жуда аниқ  ва ранглар сифатли  шаклида тасвирни сақлаш  катта 
ќажмдаги  хотира жойини  талаб қилади.  

Аммо шунга қарамасдан пиксели моделлар бадиий компьютер 
графикасида  энг кўп   ишлатилади. 
Векторли модел 
Векторли модел ахборотлар таркиби  пикселларга эмас, балки  анча катта 
семантик юкланган объектлар  тасвирига  мос келади.  Соддароқ қилиб 
айтилса, векторли моделда  ахборотлар таркиби  очилган чизиқларга  ёки 
ёпиқ контурларга (тасвир ќосил қилинувчи) мос келади. Ќар бир шундай 
модел мустақил объектга мос келади. Векторли тасвирнинг исталган 
объектнини таҳрирлаш мумкин (силжитиш, масштаблаштириш, 
атрибутлари қийматларини ўзгартириш). 
Векторли моделнинг афзаллик томонлари: 
1. Векторли модел тасвирини сақлаш учун анча кам хотира ќажми 

ишлатилади, чунки ҳар бир пикселлар тўғрисидаги ахборотлар  
эмас, балки объектларнинг аргументлари қийматлари  ва  турлари 
тўғрисидагина  ахборотларни сақлайди. Компьютер ана шу компакт 
модел билан ишлайди. Пикселли тасвирга фақат чоп қилишда, 
мониторга чиқаришда ўтказилади.  

2. Векторли тасвир исталганча даражада деталлаштириб таркиблашни, 
ќоќлаган вақтда эса алоќида объектни  ёки объектлар гуруќини  мос 
келтириши мумкин. Бу имконият тасвирланувчи объект  
таркибининг модел таркибига мос келтирилишини таъминлайди. 
Масалан, портретда алоќида номланган объектлар гуруќи бурун, 
ўнг кўзга, чап қулоққа ва ҳ.к. мос келиши мумкин. Бу эса  
тасвирнинг исталган қисми билан алоќида ишлаш имкониятини 
яратади.  

3. Векторли моделда тасвирлар исталганча мастаблаштирилиши 
мумкин, бунда тасвир  бузилмайди. 

4. Векторли моделда матнлар алоќида объектлар категорияси билан 
ифодаланадилар. 

Векторли моделнинг камчиликлари. 
 Векторли моделга ҳар хил турдаги кўплаб объектларнинг 
киритилиши бу тасвирнинг тузилишини ўрганишни  қийинлаштиради. Шу 
сабабли векторли модел билан ишловчи  дастурларни ўрганишга анча  кўп 
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вақт сарфланади. Аслида бу икки модел ќам компьютер графикасида  
бирга ишлатилади. 
Тўрли модел 
 Пикселли ва векторли моделлар икки ўлчамли тасвирларни 
компьютерда сақлашга мўлжалланган ва компьютер графикаси билан 
шуғулланувчилар уларнинг бири ёки уларнинг комбинациялари 
усулларидан фойдаланиб икки ўлчамли графика яратишган. Одатда бу 
усуллар кўпгина тасвирларни ифодалашда етарли бўлмай қолади. Ана шу 
ќолларда турли моделларнинг усуллари ишлатилади. Масалан, саќна 
ракурсларини тасвирлашда, битта саќнада ќар хил объектларни 
тасвирлашда тўрли моделлар ишлатилади.  Аммо тўрли модел тасвирни 
эмас, балки  уч ўлчамли  геометрик  объектларни сақлашга мўлжалланган. 
тўрли моделнинг асосий таркибий бирлиги, учбурчакли  қирралар, 
баландликлар, қирралар ќисобланади. Агар, тўрнинг иккита ва ундан 
ортиқ учбурчаклари битта текисликда ётсалар, улар кўпбурчак ёки 
полигонларни ташкил этишади. Ҳар бир учбурчакли қиррада учта  
баландлиги ва уларни бирлаштирувчи яна учта қирраси бор. Шундай 
қилиб,  тўрли моделнинг асосий структура бирлиги сифатида қирра 
баландликлари ишлатилади. Уч ўлчамли фазонинг фундаментал 
хусусиятларидан келиб чиқиб исталган уч ўлчамли сиртни олдиндан 
берилган учбурчакли қирраларга эга тўрлар билан бериш мумкин.  
Тўрли моделнинг афзалликлари 
1. Тўрли модел тасвирга эмас, балки объект формасига мос келади ва 

улар ўзларида исталган икки ўлчамли моделларга қараганда кўпроқ 
ахборотларни сақлайди (шу сабабли шу  нуқтаи назардан уч ўлчамли 
графика тасвирни эмас, балки кўпрок скулптурани ифодалайди).     

2. Тўрли модел перспектива илюзияларини ясаш масалаларини 
автоматик ечиш имкониятини яратади.  

3. Тўрли модел минимал ҳаражатлар билан моделлаштирилган саҳнани 
исталган ракурс билан тасвирлашни таъминлайди. 

4. Тўрли модел анимацияларни ифодалашда жуда қўл келади. 
Тўрли моделнинг камчиликлари 
1. Тўрли моделнинг баддий имкониятлари пикселли ва векторли 

моделларникига қараганда камроқдир. 
2. Мураккаб моделларни яратишда қирралар сони ниќоятда тез кўпая 

боради, бу эса жуда катта ќисоблашларни амалга оширишга олиб 
келади.  

 
Сaвoл вa тoпшириқлaр 
 
1. Пикселли модел. 
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2. Векторли модел. 
3. Тўрли модел. 
4. Пикселлли моделнинг афзалликлари ва камчиликлари. 
5. Векторли моделнинг афзалликлари ва камчиликлари 
6. Тўрли моделнинг афзалликлари ва камчиликлари. 
8. Растр тушунчаси. 
9. Моделлларнинг бадиий  имкониятлари. 
10. Семантик юкланган объектлар тушунчаси. 
11. Тўрли моделнинг асосий таркибий  бирлиги. 
12. Тўрли моделнинг перспектива иллюзияларини ясаш    
      масалаларини  автоматик ечиш имконияти. 
13. Ракурс тушунчаси. 
14. Пикселллар йўқотилиши қачон юз беради. 
15. Саќна ракурслари тушунчаси. 
16. Бадиий  компьютер графикаси тушунчаси.  
 

 
 

4-Маъруза.  График тасвирларни қайта ишлаш, компьютер ранг 
моделлари 

 
 
Маъруза режаси: 
 
1. Рангнинг  муќим тасвир яратиш инструменти сифатида    
    бажариш функциялари. 
2. Штрихли (нуқтали) тасвирлар.   
3. Монохром тасвирлар. 
4. Индекслаштрилган ранглар ва ранглар камалаги. 
5. RGB модели. 
6. СМУК модели. 
7. Чиқариш қурилмаларининг ечаолиш имкониятлари. 
8. Монитор экрани. 
9. Принтерлар ва фотонабор автоматлари. 
10. Керакли ечаолиш қийматларини xисоблаш. 
11.  Аниқлиги оширилган ранг моделлари. 

 
Таянч сўзлар ва иборалар: 
 
Dpi, bpp,  рангнинг функциялари, штрихли (нуқтали) тасвирлар, монохром 
тасвирлар, индекслаштирилган ранглар ва ранглар камалаги, RGB модели, 
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СМУК модели,чиқариш қурилмаларининг ечаолиш имкониятлари, 
принтерлар ва фотонабор автоматлари, ранг моделларининг ранг 
фазоси, слайдлар, SuperVega   стандарти, adobe, corel, metacreations, pdf 
формати, штрихли (нуқтали) тасвирлар, индекслаштирилган  ранглар, 
аддитив  моделнинг xал қилувчи  имконияти, экран ва мультимедиали 
иловалар, линиатура, экран ва мультимедиали иловалар, SuperVega 
стандарти, ечаолиш имконияти, полиграфик растр. 
 
 Ранг муќим тасвир яратиш инструменти ќисобланади. Ранг 
тасвирнинг таркибий қисми  сифатида  иккита функцияни бажаради: 
1. У тасвирланувчи  предмет хақидаги ахборотларни кодировка қилиш 

функциясини  бажаради. 
2. Предметни кўраётган кишида маълум бир эмоцияларни ќосил 

қилдирилишни   амалга оширади. 
Масалан, оқ қора тасвирланган тўти расми жуда кам ахборот сақлайди. 
Рангли тўти расми эса жуда бой ахборотларни сақлайди ва кишини ўзига 
жалб қилади. Ранг асосида частотали электромагнит тўлқинлари табиати  
ётади. Ќар хил узунликдаги ранг тўлқинлари инсон кўзига ҳар ҳил таъсир 
қилади. Кўриш органларининг табиатига кўра рангни англай билишлик - 
бу субьектив жараёндир. У кўпроқ инсоннинг индивидуал қобилиятларига  
боғлиқ. Ќатто  нормал кўриш хусусиятига эга кишилар ќам рангларни ќар 
хил қабул қилишади. 
Штрихли (нуқтали) тасвирлар   
   Штрихли (нуқтали) тасвирлар  - тасвирларда ҳар бир пикселл икки 
хил рангни акслантиради: фон (кўпинча оқ) ва олдинги план (кўпинча 
қора). Анъанавий  графикада бундай тасвирларга оқ қоғозда ручка билан  
чизилган гравюра, расмлар ва бошқалар киради. Бу модел компьютер 
графикасида  кўп ишлатилади. 
Монохром тасвирлар 
  Штрихли моделдан фарқи шундаки – уни ташкил этувчи  
пикселлар икки хил ранг  комбинацияларидан шакллантирилиши  мумкин. 
Оқ қора расмлар аслида монохром  тасвирлардир. Одатда 100 ёки 256 база 
комбинацияси ранглари ишлатилади. Монохром модели компьютер 
графикасида  кенг ишлатилади, масалан, полиграфияда. 
Индекслаштирилган ранглар ва ранглар камалаги 
 Бу модел тасвирланувчи  предмет тўғрисидаги хамма ранглар 
олдиндан маълум бўлганда ишлатилади. Бу моделнинг асосий 
инструменти ранглар камалаги xисобланади. Ранглар камалаги(палитраси) 
деб маълум бир натурал сонларда белгиланган ранглар жадвалига айтамиз. 
Ранг  номерларининг  рангларга мос келишини таққослаш  RGB  модели 
орқали амалга оширилади.  Ранглар камалаги жадвалига оқ ва қора 
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ранглар ҳам киритилади ва жадвалда битта қатор ранг ёрқинлигини  
аниқлаш учун ишлатилади. Тасвирларнинг информацион модели 
индекслаштирилган ранг камалагидан ташқари тасвирлар ранг индекслари  
пикселлари дискрепторлари ишлатилади. 

Дастлабки  рангли  компьютерларда асосан индекслаштирилган 
ранг моделлари иллатилган. Қайд қилинган тасвирда   индекслаштирилган  
ранглар камалагида кўпи билан 255 ранг ишлатилади. Ҳозирги вақтда, 
айниқса мультимедиали презентацияларда, ўйинларда ва ҳ.к. ларда 
тўлигича янги ранг моделлари  ишлатилади. Бу моделнинг ҳал қилаолувчи    
ранг имконияти 4 bрр га тенг. 
RGB модели 
Моделнинг номи учта инглиз сўзлари Reg(қизил), Green(яшил) ва Blue 
(Кўк) нинг бош ҳарфларидан ташкил топган. Бу уч ранг инсоннинг кўриш  
ва рангни ажратиш физиологик имконияти асосида танланган. Қолган 
ҳамма ранглар  шу учта база ранглар  комбинацияси асосида яратилади. Бу 
моделнинг такомиллаштирилган кўриниши аддитив RGB дейилади. 
Аддитив  моделнинг ќал қилувчи  имконияти 24 bpp га тенг. RGB нинг 
ранг фазосини (ќамма рангларини) куб шаклида тасвирлаб, унинг 
қирраларида ва ичида ҳамма рангларни жойлаштириш мумкин: 
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e 
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Координата бошида нурланиш йўқ, шу сабабли бу нуқталарга қора ранг 
мос келади. Инсон кўриш органига энг яқин нуқта (куб нуқтаси) учта 
интенсив нурланишлар кесишиш нуқтаси бўлади. Демак бу ерда оқ ранг 
ҳосил бўлади. Қора ва оқ нуқталарни кубнинг катта диоганали 
бирлаштиради. Бу ерда монохрон ранглар пайдо бўлади. Кубнинг учта  
баландликларига жойлашган бўёқлар база ранглари дейилади (улар 
координата ўқларига жойлаштирилган). Қолганлари ёрдамчи ранглар 
дейилади. Улар иккитадан база бўёқларининг  силжитилишидан ҳосил 
қилинган.  
СМУК модели 
 СМУК сўзи Cyan(зангори), Magenta(тўқ қизил), Yellow(сариқ) 
сўзларининг бош ҳарфларидан ва Blacк(қора) сўзининг охирги ҳарфидан 
ташкил топган. СМУК модели акслантирган ранглар ишлатилиши лозим 
бўлганда  ишлатилади. Бу ҳoлда ярим кўринувчан қоғозларга ранг 
ўтказилади. Бу қођоздан ўтишида ундан фақат баъзи бир спектрал 
компоненталар ўтади. Бу ҳoл эътиборга олиниб  бу моделни  кўпинча 
субтрактив модел (баъзи рангларни ажратувчи)  деб юритиша бошланди.   
  
                

Аниқлиги оширилган ранг моделлари 
 
 Полиграфик технологияларнинг ривожланиши ва жуда 
такомиллаштирилган чоп қилиш қурилмаларининг яратилиши субтрактив  
моделнинг камчиликларини аниқлади. Рангларни қабул қилиш 
аниқлигини оширишга уринишлар моделнинг рангларни ҳосил қилиш 
имкониятини оширишга олиб келди. Қанчалик тасвирларни 
шакллантиришда  формалар кўп қатнашса шунчалик ранг сифати юқори 
бўлади. Ҳозирги вақтда кўпгина  аниқлиги оширилган  ранг моделлари 
ранг тизимлари таркибига киритилган. «Ранг тизимлари» ранг 
моделларидан  ташкил топган бўлиб, махсус дастурий таъминот билан 
таъминланган. Бу дастурлар компьютер графикасининг асосиини ташкил 
этади. Улардан энг кўп тарқалгани ( ранг тизимлари) Pantone Hexachrome  
ва  CMYК+ Special  ҳисобланади.  
Чиқариш қурилмаларининг ечаолиш имкониятлари 
 Пикселлли тасвирларни ифодалаш учун ҳар хил қурилмалар 
ишлатилади. Аммо кўпинча пикселлли тасвирларни ифодалаш учун 
принтерлар, мониторлар слайдларга чиқарувчи қурилмалар ва пленкаларга 
чиқариш қурилмалари ишлатилади. 
Бу ифодалаш қурилмаларининг ҳар бирининг ўзига хос хусусиятлари бор. 
Бу специфик хусусиятлар  қурилманинг пикселли ифодалаш имкониятини 
ва   ечаолиш имкониятини аниқлайди.  
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Монитор экрани 
 Мониторнинг аппаратли ечаолиш имконияти унинг электрон-
нурли трубкасининг тайёрланиш технологияси билан ёки суюқ кристалли 
панели билан аниқланади ва улар пикселлларни ифодаловчи ячейкаларига 
таъсир қилади ва ечаолиш имкониятини аниқлайди. 
  SuperVega стандарти монитор экранинг горизонтали бўйича 800 
пикселлни ва вертикали буйича 600 пикселлни ифодалаши кўзда тутилган. 
Диагонал ўлчами 14 дюйм бўлган мониторда бу параметрлар ҳар дюймга 
96 пикселл ечаолиш имкониятини аниқлайди. Macintosh платформаси 
стандарт мониторлари ҳар дюймга 72 пиксел ечаолиш имкониятини 
аниқлайди (горизонтал бўйича 640 пикселл ва вертикал бўйича 480 
пикселл). Замонавий мониторларда фойдаланувчи ўз операцион 
системасининг имкониятидан фойдаланиб бир нечта ечаолиш 
имкониятларидан ўзига кераклисини танлаб олиш имкониятига эга 
бўладилар. Мониторнинг аппарат еча олиш имконияти пикселли 
ифодаланиш имконияти билан боғлиқ эмас. Агар бу катталикларнинг 
сонли қийматлари устма-уст тушса экранда тасвир натурал ўлчамда 
ифодаланади. Агар тасвир ифодаланиши  монитор ечаолиш имкониятидан 
катта бўлса, у ҳолда  экрандаги тасвир натурал тасвирдан катта бўлади.  
Масалан, пикселли ечаолиш имконияти 300 dpi бўлиб, томонлари 1 
дюймга тенг квадрат тасвир қаралаётган бўлсин. Аппарат ечаолиш 
имконияти 72 dpi (dots per inch, dpi) бўлган мониторга чиқарилишда 
квадрат ўлчами 4 бароваридан ошиқроқ катта бўлиб чиқади. Демак бу 
параметрлар устма уст тушиши керак.  
Принтерлар ва фотонабор автоматлар 
  Лазер принтерларга ёки фотонабор автоматларга пикселлли 
тасвирларни чиқаришда аппарат ечеаолиш имконияти  нуқта учун 
дюймлар билан ҳисобланади(dots per inch,dpi). Одатдаги монохром ва 
лазер принтерлари одатда 300 дан 600 dpi ечаолиш имкониятига эга 
бўлишади. Аммо замонавийлари эса 1200 dpi  ечаолиш имкониятига ҳам 
эга бўлиши мумкин.  
 Фотонабор автоматлари типографияларда ишлатилиб пикселли 
ифодаланишларни 1200 дан 5000 dpi  ва ундан ортиқ  ечаолиш 
имкониятини яратиб беришади. Аппарат ечаолиш имкониятида 
ишлатилаётган нуқталар, бу принтер нуқталаридир. Принтер нуқтаси деб 
тонер заррачалари билан тўлдирилиши лозим бўлган мумкин бўлган 
минимал ўлчамли соҳага айтамиз. Аммо бу жуда кичик ўлчам бўлгани 
учун биз одатда  каттароқ структурали бирлик – растр элементлари билан  
ўлчанади. Полиграфик   элемент ёки типографик растр сифатида  қайд 
қилинган ўлчамга эга квадрат соҳалар олинади. Унинг ўлчами 0 дан 100% 
гача етиши мумкин. Монохром чоп қилишда пикселли тасвир битта растр 
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билан амалга оширилади. Рангли чоп қилишда эса  керакли ранг соҳага              
4 та растр орқали берилади.  Растрларнинг устма уст тушмаслиги учун ќар 
бир растрлар горизонтал бўйича маълум бир бурчак остида ўтказилади.   
Типографик растрнинг асосий ҳарактеристикаси – линиатура дейилади. 
Линиатура чизиқдаги дюймлар билан ўлчанади (dots, per inch, dpi). Растр 
чизиқлари эса горизонтал бўйича маълум бир бурчак остида туширилади.  
 
 Керакли ечаолиш қийматларини ҳисоблаш  
 
  Пикселлли тасвирлар билан ишлаш назарда тутилган исталган  
графика устида ишлашдан олдин унинг ўлчамлари ва ечаолиш имконияти 
аниқланиши лозим. Бу параметрларни танлаш келажакда керакли 
тасвирни танлашни ва у билан ишлашни осонлаштиради.    
 Пикселлли тасвирларнинг ечаолиш факторини аниқлаш  асосан  
информацион махсулотнинг якуний ифодаланишини таъминлайдиган 
технологияга боглик. Масалан, офсет усули билан қандайдир тираж 
полиграфик қурилмаларда чоп қилинаётган бўлса, тасвир ечаолиши  
имконияти мультимедияли презентацияларга кирувчи ечаолиш 
имкониятидан катта бўлади.  
Экран ва мультимедиали иловалар 
 Катта экранда тасвирларни демонстрация қилишда ишлатиладиган 
кўпгина замонавий проекцион қурилмалар 640х480 ёки 1024х768 
пикселлли ифодаланишга мўлжалланган. PAL телевизор стандарти  эса  
тасвирларни 525х480 пикселлли ифодалашга мўлжалланган. Тасвирларни  
проектор экранига, мониторга, телевизорга чиқаришда аппарат ечаолиш 
имкониятидан  катта ечаолиш  имкониятини яратиш шарт  эмас. Аппарат 
экран ечаолиш имкониятидан пикселли тасвир имкониятини ошириш бу 
тасвирнинг реал  кўринишини бузиши мумкин.  
 Тасвир реаллигини ошириш учун одатда кўплаб ранг 
хусусиятларини эътиборга олувчи видеокарталарни ишлатиш маъқул 
бўлади.  
Слайдлар 
 Тасвирларни слайдларда ифодалаш учун плёнкага чиқаришни 
таъминловчи махсус қурилмалар ишлатилади. Бу қурилмаларнинг аппарат 
ечаолиш имконияти 2048х1366 пикселллардан то 4096х2732 
пикселлларгача етказилиши мумкин. Бу ишлар анча қимматга тушиши 
мунособати билан бу ишлар асосан полиграфия корхоналарида амалга 
оширилади.  
Чоп қилиш 
 Олдин таъкидлаганимиздек, типографик растрнинг асосий 
ҳарактеристикаси – линиатура дейилади. Линиатура  чизиқдаги дюймлар 
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билан ўлчанади (dots, per inch,dpi). Растр чизиқлари эса горизонтал бўйича 
маълум бир бурчак остида туширилади. Полиграфик растрларни чоп 
қилишга чиқаришда полиграфик растр горизонтал бўйича маълум бир 
бурчакга оғиб чиқарилади. Шу сабабли тасвир пикселллари растр 
ячейкалари билан устма уст тушмайди Дастлабки растрни чоп қилишдан 
олдин полиграфик растрга ўтказиш лозим. Бу иш одатда растрлаш 
дейилади. Электрон чоп қилишда қуйидаги эмперик қоида амал қилади: 
пикселли тасвирни чоп қилишга чиқаришдан олдин тасвир ечаолиш  
имконияти линиатурадан 1,5 марта катта бўлиши  керак. Бу дегани  150dpi 
пикселлли  растрга эга бўлган полиграфик линеатурани чоп қилишга 
чиқаришда 225 дан то 300 dpi ечаолиш катталигига эга бўлган  
сканерлашга эришиш лозим бўлади.  
 
Сaвoл вa тoпшириқлaр 
 
1. Dpi бирлиги. 
2. Рангнинг функциялари тушунчаси 
3. Штрихли (нуқтали) тасвирлар тушунчаси 
4.  Монохром тасвирлар. 
5. Индекслаштрилган ранглар ва ранглар камалаги. 
6. RGB модели. 
7. СМУК модели. 
8. Чиқариш қурилмаларининг ечаолиш имкониятлари. 
9. Монитор экрани параметрлари. 
10. Принтерлар ва фотонабор автоматлар вазифаси. 
11. Керакли ечаолиш қийматлари кандай хисобланади. 
12. Ранг моделларининг ранг фазоси. 
13.SuperVega   стандарти. 
14. pdf формати. 
15. Штрихли (нуқтали) тасвирлар. 
16.Ииндекслаштирилган  ранглар. 
17. Аддитив  моделнинг xал қилиш  имконияти. 
18. Экран ва мультимедиали иловалар. 
19. Линиатура тушунчаси. 
20.  Экран ва мультимедиали иловалар. 
21. Субтрактив модел. 
22. Macintosh платформаси стандарти. 
34. Полиграфик растр. 
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5-Маъруза. Замонавий график тизимларидан Adobe Photoshop график 
муҳарририда ишлаш 

  
 
Маъруза режаси: 
 
1. Компьютер графикаси дастурлари хақида умумий   
     мулоќазалар. 
2. Adobe Photoshop грaфик муќаррири   
3.  Adobe Photoshop грaфик муќаррирининг  менюси. 
4.  Тасвирларни яратиш ва улар устида амаллар. 
 
Таянч сўзлар ва иборалар: 
 
Растрли грaфика, векторли графика,  муќаррир менюси, асбоблар панели 
пaнели элементлaри,  тасвир ўлчами, рaнгларни ўзгартириш ва ранг 
камалаги, «фaйл»  бўлими бaндлaри, «вид» (кўриниш) бўлими вазифаси, 
«рисунoк» (тaсвир) менюси, «эффекты» менюси, навигатор, қатламлар, 
тасвир форматлари.   
 

 
1. Компьютер графикаси дастурларини икки гуруҳга ажратиш мумкин: 

1. Векторли графика дастурлари: Adobe Illustrator, Corel Draw,  
Macromediа Flash. Ушбу дастурларда расмлар ҳар хил чизиқлар ва 
қийшиқ векторлардан иборат бўлади. 

2. Растрли  графика дастурлари. Бу дастурларда яратилган расмлар 
логотип, иллюстрациялар ва заставкалар яратишда 
фойдаланилади. Растрли графика дастурларига  Adobe Potoshop   
ва  Paint  дастурлари киради. Ушбу дастурларда  расмлар майда 
квадрат-пикселллардан иборат бўлиб, мозаика ҳoлатида расмни 
ҳосил килади. Растрли графикадан рақамли фотосуратлар ва 
сканердан олинган расмлар билан ишлаш учун фойдаланилади.  

Компьютер графикасида ҳар бир дйюмдаги пикселллар сони (ppi)  
асосий шарт бўлади. Пикселллар сони қанча кўп бўлса, шунча тасвир 
сифатлироқ бўлади. Масалан, агар  ppi=72 бўлса, у ҳoлда 1 квадрат 
дйюмга 5184 пикселл жойлашади ва унинг ќажми 6 Кб га тенг бўлади. 
Агар ppi=144 бўлса  у ҳoлда 1 квадрат дюймга 20736 пикселл жойлашади 
ва унинг ҳажми 21 Кб га тенг бўлади. Шу билан бирга мониторнинг 
кўрсатиш ва принтернинг чиқариш сифати ҳар бир дйюмга тўгри 
келадиган (dpi, 72 ёки 96 dpi) билан ва чизиқлар сони эса лазер 
принтерлари учун  (Lpi) 300-2400 гача тўђри келади.  
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Adobe Photoshop редактори профессионал график редакторларга киради. 
Дастлаб бу редактор растрли  графика билан ишлашга мўлжалланган эди, 
аммо охирги версияларида растрли ва векторли графика билан ишлаш 
интеграцияси ишлатила бошланди. Adobe Photoshop нинг инструментлари  
CorelDraw ёки  Adobe Illustrator ларнинг ёрдамисиз жуда кенг миқёсдаги 
график ишларни бажаришни таъминлайди. 

2. Векторли форматларда ишлаши  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Adobe Photoshop векторли форма ва матнларни яратиш ва чоп қилишнинг 
воситаларига эга. Бу воситалардан фойдаланиб векторли расмларни ва 
шрифтларни растрли расмлар билан бирлаштириш, уларга улаш ва жуда 
чиройли дизайн тасвирлар ҳосил қилиш имконияти яратилади. Унинг янги 
инструментлари масалан, «тўғри тўртбурчак», «бурчаклари ёй билан 
алмаштирилган тўғри тўртбурчак», «эллипс», «кўпбурчак» ва  «чизиқ»)  
жуда кўп векторли формаларни яратиш имкониятини беради.  
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Бу инструментлар нафақат махсус объектлар, балки бутун 
қатламларни яратиш учун ҳам ишлатилади. Шунингдек, Adobe Illustrator 
каби, Photoshop (7.0 ва 8.0 версиялари) векторли объектлар билан 
манипуляция қилишни таъминлайди: қўшиш (Add), айириш (Subtract), 
чеклаш (Restrict) ва инвертирлаш (Invert). Бу амаллар тезликда векторли 
объектларни мураккаб объектларга бирлаштириш  имкониятини яратади.  
Матнлар билан ишлаш  
Photoshop 7.0  ва  8.0  версиялари сифатли матнли элементлар яратиш ва 
уларни сифатли форматлаш ишларини амалга ошириш учун янги  жуда 
кўп инструментлар терилмасига эгадирлар. Масалан, деформация 
қилишнинг янги опцияларидан фойдаланиб шрифтларни бураш ва чўзиш 
мумкин. Шу ҳoлда ҳам шрифтлар таҳрирланувчи ҳoлатларда 
қолаверишади. Векторли матнларни бевосита чоп қилиш ёки улардан   
PDF-файллар яратиш мумкин.  
PDF форматига чиқариш опциялари 
Компания Adobe компанияси ўз маҳсулотлари интеграциясини давом 
эттириб, Photoshop да янада Adobe Portable Document Format (PDF) 
формати ишлатилиши яхшиланди. 
Қатламлар стили 
 Photoshop 8.0  да қатламларда махсус эффектлар яратиш  учун интиутив 
интерфейс яратилган. Махсус қатламлар учун эффектлар танлаш бўлимии 
киритилган.   
Тасвирларни деформация қилиш  
Photoshop даги Liquify буйруғи билан тасвирни деформация қилиш 
мумкин. Масалан, интерактив чўзиш, бураш, қисиш, соҳанинг  баъзи 
қисмларини кичрайтириш ва кенгайтириш ҳисобига тасвирларни  
деформациялаш мумкин.   
Photoshop8.0 нинг Adobe Image Ready дастури билан интеграллашуви 
 Adobe Photoshop 8.0 да Adobe Image Ready дастури билан 
интеграллашуви натижасида  Web учун ўз инстументлари кенгайтирилган. 
Графика яратиш учун векторли воситалар билан интеграллашув  ва  янги  
«Қатлам учун стил» тушунчаси киритилиши билан  Web  учун жуда реал 
тасвирлар яратиш имконияти яратилган. ImageReady дастури Web учун 
анимациялар яратиш ва ҳар хил график эффектлар яратиш учун хизмат 
қилади.  
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3. Adobe Photoshop 8.0 интерфейси элементлари 
 
Меню сатри элементлари: 

 
Меню қатори тагида хусусиятлар соҳаси қатори жойлашган: 
 
 
 
Унинг чап томонида иш қуроллари соҳаси жойлашган (Toolbox –иш 
куроллари панели). Иш соҳасининг ўнг томонида ҳар хил  ёрдамчи 
соҳалар жойлашиши мумкин: Слои-Layers, История-History, Каналы-
Channel, Цвета_Color, Стили-Style, Свойства кисти-Brushes, Свойства 
шрифта-Charater ва ҳ.к. Ушбу соҳаларни хам Окно(Window)  
менюсидаги буйруқлар билан экранга чиқаришимиз ва экрандан олиб 
ташлашимиз мумкин. Ёрдамчи соҳани кичиклаштиришимиз ҳам мумкин. 
Бунинг учун соҳанинг юқорисидаги кичкиналаштириш (свернуть) 
тугмачасидан фойдаланамиз. Ёрдамчи соҳаларда  бизга энг керакли  бу иш 
қуроллари соҳасидир ва қатламлар соҳаси (Слои-Layers) киради. Янги  
PhotoShop файлини яратиш ёки эски файлни қайта очиш учун 
Файл/Создать ёки Файл/Открыть буйруқлари ишлатилади. Бу буйруқдан 
кейин экранда янги файл яратиш соҳаси  ойнаси очилади.  Бу ойнада 
унинг номини Name, турини Preset, Width-энини, бўйини-Height, 
Resolution- сифатини, ранглар ҳoлатини, фон рангини танлашимиз керак 
бўлади. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ҳаммасини танлагач ОК тугмаси босилади ва экранда янги 
бўш соҳа  ҳосил бўлади. 

  Тўртбурчак соҳа танлаш Restangular marquee). 

   -Айлана соҳа танлаш (Elliptical marquee). 
Танланган соҳага қўшимча соҳа қўшиши учун Shift  
тугмасини босиб, ушбу тугмадан кайта фойдаланамиз.  
Агар Alt тугмасини босиб  соҳа танласак, у ҳолда 
танланган соҳадан олиб ташлаш маъносини билдиради.  
Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Shift ва Alt тугмалар ҳаракатларига  ўхшаш 

холатларни танлаш. 
 Feather-ёрдамида танланган соҳа 

чегараларининг қалинлиги. 
 Style- Сохаси ёрдамида танлаш 

ҳолатини  танлаймиз. Normal 
чексиз соҳа, Сonstrained.   
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Лассо-Lasso-[L] -ихтиёрий соҳани танлаш. Агар танлаганимизда Alt 
тугмасини босиб турсак, у ҳoлда  бизнинг лассо кўпбурчак соҳага  ўхшаб  
соҳа танлайди ва Alt  тугмасини босганимизда танланган соҳа ёпилади.  

Aspect Ratio  ёнлари кўрсатилган пропорциялардаги соҳа танлаш, 
Fixed size  -ёнлари кўрсатилган катталикдаги соҳа танлаш.  

 Кўпбурчак лассо –Polygonal lasso [L]-кўпбурчак соҳани танлаш. 
Танланган соҳани  ёпиш учун ёки cичқонча билан икки марта босиш керак 
ёки Сtrl  тугмачаси босилиши керак. 
Магнит Лассо –Magnetic lasso-[L] нглар бўйича соҳа танлаш. Компьютер 
танланган нуқтани бекор қилиши учун  Backspase  тугмасини босиш керак. 
Танланган  соҳага қўшимча соҳа қўшиш учун  Shift тугмасини босиб 
туриб ушбу тугмадан қайта фойдаланамиз. Агар Alt тугмасидан 
фойдаланиб соҳа танласак, у ҳoлда  танланган соҳадан олиб ташланади.  
Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Shift ва  Alt  тугмалар ҳаракатларига  ўхшаш ҳoлатларни танлаш. 
 Feather- соҳаси ёрдамида  танланган соҳа  чегараларининг 
қалинлиги. 
 Anti-Aliased опцияси танланган соҳанинг чегаралар рангини  кўзга 
кўринмас қилиб бир бирига мослаш. 
 Width –танланган соҳанинг  чегаралар  қалинлигини  ўзгартириш. 
 Edge Contrast –магнит лассонинг сезгувчанлигини ўзгартириш. 
 Frequency магнит лассонинг  автоматик равишда  қўйиладиган  
нуқталар ўртасидаги   масофа. 
 
                  Сеҳрли тайёқча- Magic wand-[W]  бир хил рангли соҳани 
танлаш. Танланган соҳага қўшимча соҳа қўшиш учун Shift тугмасини 
босиб туриб ушбу тугмачадан қайта фойдаланамиз. Агар Alt тугмасини 
босиб соҳа танласак, у ҳoлда танланлган соҳадан олиб ташлаш 
тушунилади.  
Хусусиятлар сатрида қуйидагилар фаол бўлади: 
 Shift ва  Alt  тугмалар ҳаракатларига  ўхшаш ҳoлатларни танлаш. 
 Tolerance – соҳа танлашда сехрли таёқчанинг сезувчалигини 
ўзгартириш. 
 Anti-Aliased опцияси танланган соҳанинг чегаралар рангини кўзга 
кўринмас қилиб бир бирига мослаш. 
 Contiguous опцияси –танланган соҳа битта умумий бўлишини ёки 
бир нечта қисмдан иборат бўлишини таъминлайди. 



25 
 

 Usе All Layers опцияси –сеҳрли тайёқчанинг соҳа танланганлиги 
хамма қатламларга тегишли ёки фақат асосий бўлган қатламга 
тегишлигини таъминлайди.  
Танланган соҳа устидан биз ҳар хил ҳаракатларни бажаришимиз мумкин. 
Масалан, хотирага қирқиб  олиб ёки нусха олиб, янги қатламга уни 
қўйишимиз мумкин. Ёки унинг ҳажмини ўзгартириш ва айлантириш 
мумкин. Ва ниҳоят уни иш соҳа бўйлаб силжитишимиз мумкин.  

 Силжитиш-Move(перемещение )-[v]-танланган соҳани иш соҳа 
бўйлаб  ҳаракатлантиради. Агар Alt тугмасини босиб ҳаракатланишни 
бошласак, у ҳoлда танланилган соҳанинг нусхаси олиниб, у 
ҳаракатланади. Агар Shift  тугмасидан фойдалансак, у ҳoлда танланган 
соҳа  фақат вертикал ва горизонтал ҳаракатланади. Танланган соҳани 
клавиатурадаги йўналиш стрелкалари орқали хам ҳаракатлантириш 
мумкин, шунда ҳар бир стрелка босилганда танланган соҳа 1 пикселга 
силжийди.  
 Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Auto Seleсt Layer соҳаси – сичқонча ёрдамида фаол бўлмаган 
қатламни фаол қилиш. 
 Show Bounding Box - танланган соҳа чегараларида рамка хосил 
қилиш. Ушбу рамка ёрдамида расмни чўзиш  ва айлантириш мумкин 
бўлади. 
 Кадрловчи –Crop-[c]- файлнинг керак эмас қисмларини  қирқиб 
олиб расмни кичкиналаштириш. Бунинг учун керакли соҳани  танлаб олиб 
Enterни босамиз, агар танланишни бекор қилмокчи бўлсак,  ESCни 
босишимиз керак.  

  Бўлиш пичоқчаси –Slice-[k] тасвирни бир нечта қисмга бўлиб, уни 
Интернетда қисмларга бўлинган ҳoлатда чиқариш учун тайёрлаб 
қўйилади.  
Бўлинишларни созлаш – Slice Seleсt- [k] бир нечта қисмга бўлинган 
тасвирни созлаш. 

Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Stуle соҳаси ёрдамида танлаш ҳoлатини танлаймиз. Normal чексиз 
соҳа, Constrained Aspect Ratio –ёнлари кўрсатилган пропорциялардаги  
соҳа танлаш, Fixed size  -ёнлари кўрсатилган  катталикдаги соҳа танлаш. 
 Show Slice Numbers –қисмларнинг номерларини кўрсатиш ва 
кўрсатмаслик.  
 Line Color –бўлиниш чегараларининг рангини ўзгартириш. 
 Promote To User Slice – бўлинишларни автоматик горизонтал ва 
вертикал давом эттириш. 
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 Slice Options тугмачаси- бўлакчанинг хусусиятларини ўзгартириш 
ва созлаш. 
Adobe Photoshop дастурининг расмни таҳрирлаш иш қуроллари 
 
Қалам- Pensil –[B]-қалам ёрдамида чизиш. Муйқалам –Paintburush(кисть)-
[B] чизиш иш қуроли. Муйқаламдан фодаланилаёган вақтда  Shift  
тугмачасини босган ҳoлда сичқонча билан чизсак, у ҳoлда тўғри чизиқлар 
чизилади. Shift тугмачаси босилган ҳoлда  сичқонча ёрдамида нуқталарни 
хам бирлаштириш мумкин. Мўйқалам билан чизилган  чизиқлар қаламга 
қараганда  чегаралари аниқ  кўринмайди. 
Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Brush- қалам турини ва қалинлигини танлаш. 
 Mode- чизиқларни расм устида чизилиш ҳoлатини ўзгартириш. 
 Opaсity-чизиқлар кўринмаслик даражасини ўзгартириш. 
 Auto Erase –қалам фақат бўш соҳада чизиш мумкинлигини 
кўрсатади. 
 Wet Edges (мокрые края-«ҳўл чегаралар») –акварель билан чизиш 
эффекти.  

 Нусха олувчи «Штамп»-Clone Stamp-[S] – расмнинг бошқа қисмига 
ўхшаш соҳалар яратиш. Нусха олувчи  соҳани танлашда Alt тугмасидан 
фойдаланамиз. Нақшли штамп – Pattern Stamp(штамп узора)-[S]- Pattern –
соҳасида танланган нақш билан кўрсатган соҳани тўлдириш. Агар нақш 
яратмокчи бўлсак, у ҳoлда  аввало тўртбурчак ясаш иш қуроли билан 
(Rectangular Margue) нақш жойлашган соҳани танлаймиз, сўнгра «Правка» 
менюсига кириб унинг ичидаги «Назначить узор»(Define Pattern)  
буйруғини танлаймиз  ва натижада шу нақш Patterns соҳасида пайдо 
бўлади.   
Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Brush- қалам турини ва қалинлигини танлаш. 
 Mode- чизиқларни расм устида чизилиш ҳoлатини ўзгартириш. 
 Opaсity-чизиқлар кўринмаслик даражасини ўзгартириш. 
 Aligned  –нусха олинган соҳани  сичқонча ҳаракатидан кейин 
ўзгариши. 
 Use All Layers  опцияси –сехрли таёқчанинг соҳа танланганлиги 
хамма қатламларга тегишли ёки фақат асосий бўлган  қатламга  
тегишлигини таъминлайди.  
                   Олдинги ҳoлатга қайтиш –History Brush (кисть ппредистории) –
[Y] бу иш қуролини танлашдан олдин биз қайтиш керак бўлган ҳoлатни 
ёрдамчи соҳада белгилаб қўйишимиз керак. Сўнгра ушбу иш қуроли 
билан  дастлабки ҳoлга қайтиш қилинади. 
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Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Brush- қалам турини ва қалинлигини танлаш. 
 Mode- чизиқларни расм устида чизилиш ҳoлатини ўзгартириш. 
 Opaсity-чизиқлар кўринмаслик даражасини ўзгартириш. 
 Stule-махсус эффект ҳoлатини танлаш. 
 Fidelity –ранглардан фойдаланиш ҳoлати. 100%  расмдаги ранглар, 
0% ранглар танланилган ҳoлати. 
 Area – иш қуролининг таъсир этиш соҳасини танлаш. 
 Spacing –иш қуролини фақат ўхшаш рангли соҳаларда ишлаш ёки 
ҳар хил рангли соҳаларда ҳам ишлаш. 
Aэрограф – Airbrush- [J] пульвизатор иш қуроли. Ундан фойдаланиш 
вақтида  Shift  тугмачаси босиб сичқонча билан чизсак, у ҳoлда тўғри 
чизиқлар чизилади. Shift тугмачасидан  фойдаланиб берилган нуқталарни 
ҳам бирлаштириш мумкин. 
Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Brush- қалам турини ва қалинлигини танлаш. 
 Mode- чизиқларни расм устида чизилиш ҳoлатини ўзгартириш. 
 Pressure – краска сепиш кучи.  

 Ўчиргич (Eraser (ластик))- [E] –асосий қатламда расм ўчириш, Shift 
тугмачаси босилган ҳoлда сичқонча билан нуқталарни бир бири билан 
боғлаш ҳам мумкин.  
Фон рангни ўчиргич-Baсkground (ластик фона) –[E] фақат фонни ўчириш. 
Сеҳрли ўчиргич- Magiс Eraser (волшебный ластик)-[E] ўхшаш рангли 
соҳаларни ўчириш. 
Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Ўчиргич ҳoлатларини танлаш-мўйқалам (Paintbrush-кисть). 
аэрограф – Airbrush  қалам (Pensil), блок(Block). Блок ҳoлатида cичқонча 
курсори 16х16 пикселл квадрат кўринишда бўлади. Блок катталиги xеч 
ўзгармайди, шунинг учун расмни 1600 %  масштабида кўрганимизда ушбу 
расмнинг 1 пикселл катталигигиа тенг бўлади.  
 Tolerance сезгувчанлиги –ранг ўчиришда сезувчанлигини 
ўзгартириш. 
 Protect Foreground Color –олдинги ранг ўчирилишидан ҳимояланиш. 
 Ўчириш йўли (Limits)- факат  чекланган соҳа ичида, (Discontiguous), 
бир хил рангли, (Сontiguous) мўйқалам ўртасидаги рангли (Find Edges)  
ўхшаш рангли  чегаралари. 
 Sampling – ўчириладиган ранг танлаш ҳoлатини ўзгартириш. 
 Anti –Aliased –чегараларни ёйилиши- ўчириладиган соҳа чегаралар 
ҳoлатини ўзгартириш. 
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 Use All Layers  опцияси сехрли ўчиргич  таъсири ҳамма қатламларга 
тегишли ёки фақат асосий бўлган қатламга тегишлигини  таъминлайди.  
 Opacity – ўчириш даражасини ўзгартириш. 
Градиент ранг бериш - Gradient-[G]- градиент ёки битта рангдан 
бошқасига ўтиш ранги билан танланган соҳани тўлдириш.  

 Фон рангини бериш- Paint Bucket (чўмич, ковш) –[G] –белгиланган 
соҳани битта ранг ёки нақш (тайёр ва биз яратган) билан тўлдириш. 
Хусусиятлар қаторида қуйидагилар фаол бўлади: 

 Gradient Editor –градиент рангли ҳoлатларни ўзгартириш. 
 Градиент турлари: чизиқли (Linear Gradient), радиал (Radial gradient), 

бурчакли (Angular gradient), ойна аксли (Reflekted gradient), ромбли 
(Diomond gradient). 

 Revers градиентда биринчи ва иккинчи рангларни ўрни билан 
алмаштириш.  

 Dither градиент ранг билан тўлдирилишда чизиқлар кўринишини 
ўчириш. 

 Transparensy рангсиз соҳага рухсат бериш белгиси. 
 Ранг билан тўлдирилиши турини танлаш ранг - Foreground  ёки нақш -

Pattern. 
  Mode ранг билан тўлдирилиши ҳoлатини ўзгартириш. 
  Opacity –ранг билан тўлдирилган соҳанинг кўринмаслик даражасини 

ўзгартириш.  
 Контракстни камайтириш- Blur(размытие) [R] контрастни камайтириш 

ёки рангларни ёйиш. 
 Контракстни кўпайтириш –Smude (размывател) [R] контрастни 

кўпайтириш  ёки рангларни аниқлаштириш. 
Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Brush- сичқонча кўриниш турини ва қалинлигини танлаш. 
 Mode- рангларни ўзгартириш ҳoлатини созлаш. 
 Pressure – ёйиш кучини ўзгартириш.  
 Use All Layers опцияси ёйилиш таъсири ҳамма қатламларга тегишли 
ёки фақат асосий бўлган қатламга тегишлигини таъминлайди.  
 Finger Painting – рангга ботирилган бармоқ билан чизиш эффектига 
ўтиш.  
 
Adobe Photoshop дастурининг матн ва график шакллар яратиш иш 
қуроллари 
 
             Матн –Type (текст)-[T] –тасвирга матн қўшиш. Ушбу  иш қурол 
ишлатилгандан кейин  янги қатлам  пайдо бўлади(Text Layer). 



29 
 

Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Оддий матн ёки матн чегаралари ҳoлати. 
 Матн йўналишини ўзгартириш. 
 Матн шрифтини  ўзгартириш. 
 Матн ҳарфлар кўринишини ўзгартириш (қалин, ётиқ, тагига 
чизиқли). 
 Матн ҳарфлар катталигини ўзгартириш. 
 Матни чегаралар турини ўзгартириш. 
 Матни абзацда жойланиши: чап, ўрта, ўнг томон. 
 Матн рангини ўзгартириш соҳаси. 
 Warp Text –матнни қийшайтириш ҳoлатлари. 
 Palettes тугмаси-матн хусусиятларини ўзгартириш ойнаси билан 
ишлаш. 
 
                     
 
  
                    
 
                        Айлана- Ellipse [U]  -чизиш. 
           
               Кўпбурчак –Poly-[U] – кўпбурчак чизиш. 
                  Чизиқ –line –[U] – тўғри чизиқ чизиш. 
Махсус шакллар –Gustom Shape (произвольная фигура)-[U] ҳар хил тайёр 
шакллар чизиш.  
Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Шакл чизилиш ҳoлатини  ўзгартириш тугмалари (Янги қатламда –
Greate New Shape Layers, факат йўл Greate New  Work Path, фаол қатламда  
-Filled Region). 
 Шакл турини танлаш тугмалари. 
 Шакл чизиш  йўллари (Unconstrained –ихтиёрий, Square  тенг 
томонли, Fixed Size кўрсатилган ўлчамли, Proportional –пропорцияли). 
 Layer Style   ранг билан бўяш тури. 

 Қўл –Hand -[H] –агар расм экранга тўлиқ сиғмаса,  у ҳoлда бу иш 
қуролини танлаб сичқонча ёрдамида расмни силжитиш мумкин. Расмни 
экраннинг ўнг  ва пастки қисмларда жойлашган кўриб чиқиш соҳалар  
орқали хам силжитиш мумкин, аммо бу иш қуроли ёрдамида силжитиш 
қулайроқ ва бу иш қуролини ҳoҳлаган вақтда  «бўш жой» (пробел) 

                           Тўртбурчак_Rectangle [U] – тўртбурчак чизиш. 

Айланасимон тўртбурчак Rounded Rectangle-[U]- чизиш. 
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тугмасини  босган ҳoлда  вақтинчага ёқиб туриш мумкин. Пробелни қўйиб 
юборсангиз иш қурол яна  аввалги ҳoлатига қайтади. 
Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Actual Pixels (Strl+Alt+0) -100% экран ҳoлатига ўтиш тугмаси. Ушбу 
ҳoлатда  расмнинг бир пиксели  экрандаги 1 пикселга мос бўлади.  
 Fit On Screen (Ctrl+0) – тўлиқ экран ҳoлатига ўтиш тугмаси. Бу 
тугма ёрдамида  расм ойна ҳажмигача чўзилади.  
 Print Size – коғозга босмаланганда қандай чиқишини кўрсатувчи 
тугма.   

 Лупа-Zoom –[Z] –экрандаги расмни кўриш масштаб фоизини 
ўзгартириш. Яқинлаштириш  ва узоқлаштириш учун сичқонча билан  
керакли расм қисмига кўрсатиб босиш лозим. Буйруқлари:                              
Zoom Out[Ctrl+минус]- узоқлаштириш, Actual Pixels [Ctrl+Alt+0] –расмни  
100%  экран ҳoлатига ўтиш  тугмаси, [Ctrl+Alt+плюс] –расмни ойна билан 
биргаликда катталаштириш, [Ctrl+Alt+минус] –расмни ойна билан 
биргаликда  кичкиналаштириш, Fit On Screen [Ctrl+0]  - расм  ва ойнани 
тўлиқ экран ҳoлатига ўтказиш. 
 Хусусиятлар қаторида қуйидагилар фаол бўлади: 
 Resize Windows To Fit - расмни ойна билан биргаликда ўзгартириш 
ҳoлатини ёқиш. 
 Ignore Palettes – ойна катталашганда ўнг томондаги ёрдамчи соҳалар 
орқасига ўтиш мумкинлиги  ёки мумкин эмаслигини ўзгартириш. 
 Actual Pixels[Ctrl+Alt+0]- 100%  экран ҳoлатига ўтиш тугмаси, Ушбу 
ҳoлатда расмнинг 1 пикселл экрандаги 1 пикселлга мос бўлади. 
 Fir On Screen [Ctrl+0] –тўлик экран ҳoлатига ўтиш тугмаси. Бу тугма 
ёрдамида расм ойна ҳажмигача чўзилади.   
 Print Size коғозга босма  килиш тугмаси. 

 Перо (Pen) –[P]- сичқонча  ёрдамида нуқталар орқали  шаклни 
яратиш. Вариантлари:  
1.Ихтиёрий перо (Freeform Pen)-[P] сичқонча  ёрдамида ҳаракат  орқали  
шаклни яратиш.                                                                                                  
2.Янги нуқта қўшиш (Add Anchor Point –[йўқ] - сичқонча  ёрдамида   
шаклга янги бурилиш нуқта қўшиш.                                                                  
3.Нуқта ўчириш (Delete Anchor Point) –[йўқ]- cичқонча  ёрдамида   
шаклдан  бурилиш нуқтасини ўчириш.                                                                     
4. Нуқта ўзгартириш (Convert Point) –[йўқ]- шакл нуқталарининг 
жойлашишини ўзгартириш. 
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 Изоҳлар(Notes) –[N] – расмнинг ихтиёрий қисмига матнли изоҳ 
қўшиш. Вариантлари:  
1. Товуш изоҳлар(Audio Annotation) –[N] – расмнинг ихтиёрий қисмига 
микрофон орқали товушли изоҳ қўшиш. Пайдо бўлган ойнада Start 
буйруғи билан бошлаймиз ва Stop билан тўхтатамиз.                                                                                 
2. Томизгич(Eyedropper)- [I] – Ихтиёрий рангни  қайта асосий ранг қилиб 
танлаш. Нуқта сичқонча ёрдамида қўйилади.               
3. Рангларни солиштириш (Color Sampler)-[I].  
Measure (Ўлчагич) асбоби –[I]- Расмдаги масофани аниқлаш учун 
қўлланилади.  
 
Adobe Photoshop дастурининг меню пунктлари: Image (Образ), Select 
(Танлаш), Edit(таҳрирлаш). 
Image менюси расм рангларини,  ҳажмини ва бошқа хусусиятларини 
ўзгартириш учун ишлатилади. Унинг буйруқларининг энг асосийлари 
қуйидагилардан иборат: 
Режим(Mode)- буйруғи расм режимини ўзгартириш. Асосий режимлари: 
Grayscale - кул ранг ҳoлатига ўтказиш, Indexed Color - кўрсатилган 
ранглар сони ҳoлатига  ўтказиш (256 тагача), CMYK Color –тўртта асосий 
ранглар орқали  кодлаш(мовий, сариқ, қора ва қизгиш ранглар), RGB  
Color- учта асосий ранглар орқали  кодлаш (қизил, яшил, Кўк). 
Таҳририлаш(Adjust) –бу бўлимга жойлашган буйруқларнинг аксарияти  
расмни ранглар устидан ҳар хил таҳрирлаш амалларини  бажариш учун 
ёрдам беради;  
Levels (Ёруғлигини ростлаш), Avto Levels (Ёруғликни  автоматик ростлаш). 
Variations  - ранг балансини ўрнатиш. 
Соҳа танлаш-бу фотомонтажнинг энг асосий ҳаракатларидан биридир. Бу 
ҳаракатларга асосан Select  бўлими буйруқлари билан ишланади.  

 
 

4. Adobe Photoshopда тасвирлар яратиш ва улар устида 
амаллар  

Анимацион тугмалар яратиш 
 

Исталган Web варағи дизайнинг специфик элементларидан бири 
тугмалар (кнопкалар)дир. Adobe Photoshop дастури хилма хил тугмалар 
яратишни таъминлайди.  
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1-машқ. 
Оддий квадрат кнопкалар яратиш 
Оддий квадрат кнопкалар яратиш учун RGB форматидаги  янги хужжат 
яратамиз. Кнопка учун ранг танланади (асосий-ёрқин, фон-қорароқ). (4.1-
расм).  

 
4.1-расм.  
  
Сўнгра четларини қуйидаги буйруқ билан  ажратамиз: 

Select→Modify→Border  (Ажратиш→Такомиллаштириш→Чегара, 4.2-
расм).  

                                             
4.2-расм. Чегарани белгилаш.                 4.3-расм. Градиент билан   
                                                                        тўлдириш 

2-машқ. 
Қавариқ  рельефли кнопка яратиш 
Қавариқ рельефли кнопка яратиш учун  RGB форматидаги  янги ҳужжат 
яратамиз, уни қора ранг билан ранглаймиз, Овал инструменти ёрдамида 
овал соҳа ажратамиз  ва уни оқ ранг билан ранглаймиз. Сўнгра Gaussian 
Blur: Filter→Blur→Gaussian Blur (Фильтр→Размытие→Размытие по 
Гауссу) фильтри ёрдамида қуйидаги кўринишга келтирамиз (4.4-расм).  

                                    
4.4-расм.                                              4.5-расм 
 
Энди ажратишни Emboss: Filter→Stylize→Emboss 

(Фильтр→Стилизация→Выпуклый рисунок) фильтри ёрдамида   бекор 
қиламиз (4.5-расм).   
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3-машқ. 
Сояли қавариқ кнопка яратиш 
 
Photoshopда жуда кўп эффектлар яратиш мумкин, уларни кнопкаларда 
ишлатиш мумкин. Аммо бу имкониятлар фақат янги қатлам яратилганда  
мумкин бўлади.   

Эффектларнинг ишлатилишини қавариқ кнопкаларни яратишда 
кўрайлик. RGB форматидаги  янги хужжат яратамиз  ва унга янги қатлам 
Layer1 қўшимча қиламиз ва унда режалаштирилаётган кнопка учун айлана 
соҳа шакллантирамиз ва уни чизиқли градиент билан бир йўналишда 
тўлдирамиз. Сўнгра  

Select→Modify→Contract (Выделение→Модифицировать→Сжать)  
буйруғи билан ажратилган соҳани 4-6 пикселллар кенглигида 
қисқартирамиз ва уни олдинги градиент билан аммо тескари йўналишда 
соҳани бўёққ тўлдирамиз  (4.6-расм).  

                                              
6-расм. Соясиз қавариқ кнопка.      7-расм. Охирги варианти.   

 
Сўнгра Layer1: Layer→Layer Style→Blending Options 

(Слой→Эффекты слоя→Настройки смешивания) қатламига ўтамиз (4.7-
расм).  

 
4-машқ. 
 

Adobe Photoshop да қишки фантазиялар ясаш  
  

Дераза ойналаридаги музланишларни акс эттириш  
  
Photoshop воситаларидан фойдаланиб дераза ойналаридаги 
музланишларни акс эттириш ғояси   машҳур дизайнер Майк Хомолега 
тегишли. Бундай музланиш эффектларини ҳосил  қилиш учун RGB 
форматидаги  янги ҳужжат яратамиз ва унга музланишни акс эттирувчи 
асосий каштанинг расмини туширамиз (4.8-расм), шундан кейин унинг 
фрагментларини ранглашга киришамиз  (4.9-расм.).  
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4.8-расм. Бўлғуси музланиш орнаменти     4.9-расм. Рангланган     
                                                                           ҳoлати 

Энди қўшимча фильтрлардан фойдаланиш мумкин: KPT5 
FIBEROPTIX, агар бу имконият бўлмаса, у ҳoлда  Filter→Artistic→Rough 
Pastels (Фильтр→Художественный→Грубая пастель) фильтрини қўллаш 
лозим (4.10, 4.11-расмлар): 

                                                                   
              4.10-расм.                                               4.11-расм 
 
Энди асосий ранг сифатида оқ ранг ва асосий фон сифатида кўк ранг 

ўрнатилиб сўнгра,   
Filter→Sketch→BasRelief  (Фильтр→Набросок→Басрельеф)  

 



35 
 

фильтри қўлланилиши лозим, бу фильтр қуйидаги параметрларга эга 
бўлиши лозим: Detail — 14, Smoothness — 2   ва  Light Direction — Top 
(4.12-расм).  

 
4.12-расм. 

Агар қўшимча KPT5 FIBEROPTIX  фильтри ишлатилса, жуда ҳам 
чиройли тасвир ҳосил бўлади (4.13, 4.14-расмлар):  

       
            4.13-расм.                                                            4.14-расм. 

 
5-Машқ. 
 
 Web-саҳифалар учун фонлар яратиш 

  
Background (фон — англ.), ёки  фон текстураси — бу  исталган Web-

саҳифанинг стандарт элементи ҳисобланади. Одатда фон бирон бир 
материални ёки нарсани, букланган қоғозни, дарахтни, мармарни, булутли 
осмонни  имитация қилади. Кўпинча фон текстуралари унча катта 
бўлмаган ўлчамга эга бўлишади. Шу сабабли Web-саҳифалар учун фон 
текстураларини яратишда шу элементларни идеал бирлаштириш талаби 
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қўйилади. Фон текстураларининг кўринишлари қуйидаги расмда 
келтирилган: 

 
4.15-расм. Фон текстуралари намуналари. 
 
Кўпинча фон текстуралари мустақил ясалади. Photoshop дастурида 

махсус қўшимча фильтрлар мавжуд бўлиб, улар ёрдамида ҳам фон 
текстураларини яратиш мумкин. Adobe Photoshop 7.0  да махсус фон 
генерациясини хосил қилиш учун қўшимча фильтрлар керак бўлмайди, 
чунки бу дастурда махсус уланувчи  плагин Pattern Maker дастури бор. Бу 
дастур исталган фрагмент тасвир асосида фон текстураларини яратишни 
таъминлайди.  
Плагин  Pattern Maker  ёрдамида  фонлар яратиш 
 
Ўзимизга керакли  бирон бир тасвирни танлаб оламиз, масалан, 4.16-расм: 

          
4.16-расм.                                            4.17-расм. Ажратилган соҳа. 
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Шуни қайд қилиш керакки, фон текстураларини алоҳида 
қатламларда яратиш қулайроқдир, чунки биринчи киришишдаёқ керакли 
фон ҳосил қилиш қийиндир, қатламларни танлаш эса бу текстураларнинг 
исталганини танлаб олиш имкониятини яратади.  Шу сабабли Layer1да 
янги қатлами яратилади, унга ҳамма тасвирлар нусхаланади ва қуйидаги 
фильтр танланади: Filter→Pattern Maker (Фильтр→Генератор фонов), 
сўнгра яратилаётган фон учун керакли тўртбурчакли соҳа таналанади. 
Сўнгра қуйидаги кнопкага сичқонча билан қирсиллатамиз: Use Image Size 
(Тасвир ўлчамидан фойдаланиш).  

Энди  Generate (Генерация) кнопкасини босамиз ва экранда 
генерация қилинган текстура ҳосил бўлади. Яратилган текстурани 
катталаштириб кўриш мумкин, масалан  Zoom Tool инструменти 
ёрдамида.  

        
4.18-расм. Генерация қилинган          4.19-расм.  Web-саҳифадаги фон 
фон текстураси намунаси  
 
Энди бу фонни Web саҳифада ишлатиш мумкин. 
 
6-машқ. 
 
Дастлабки тасвир сифатида қуйидагини оламиз (булут): 



38 
 

          
4.20-расм. Дастлабки тасвир        4.21-расм. Керакли соҳани ажратиш 
 
Янги Layer1 қатламини яратамиз ва қуйидаги фильтрни оламиз: 

Filter→Pattern Maker (Фильтр→енератор фонов) ва керакли 
тўртбурчакли соҳани танлаймиз (4.21-расм).  

 
Энди  Use Image Size (Тасвир ўлчамидан фойдаланиш) кнопкасидан 

фойдаланамиз, натижада (4.22-расм) даги тасвирга эга бўламиз. Бу 
текстурага янги Filter→Pattern Maker  фильтрини қўллаймиз (рис. 11). 

 

              
4.22-расм.  Яхши танланилмаган          44.23-расм. Янги соҳа ажратиш 

фон текстураси ҳосил бўлди 
 
 
Иккинчи  босқичда xосил қилинган текстура (кулранг): 
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7-машқ. 
 
 Photoshop да  фон текстураларини қўлда яратиш  
Мато текстураси 
  

Бундай текстурани  яратиш учун қуйидаги ранг  моделлардан 
биридан фойдаланиб  янги файл яратамиз: (RGB, CMYK ёки  Lab). Асосий 
ранг сифатида қорамтирроқ ранг танлаймиз, фон ранги сифатида эса оқ 
ранг танлаймиз  ва асосий ранг билан тасвирни бўяймиз (4.24-расм).  

              
4.24-расм. Дастлабки тасвир           4.25-расм. Натижа тасвир 
 
Куйидаги фильтрдан фойдаланамиз:  Filter→Sketch→Halftone Pattern 

(Фильтр→Эскиз→Образец палитры), у қуйидаги параметрларга эга 
бўлиши лозим: Size — 1, Contrast — 5, Pattern Type — Dot (4.25-расм).  

Darken Only режимида энди Filter→Stylize→Diffuse 
(Фильтр→Стилизация→Диффузия)  фильтри танланади. Агар ранг 
тўкилиши жуда тез бўлмаса, у ҳoлда Ctrl+F  клавишларини бир ёки бир 
неча марта токи керакли эффект олинмагунча  босиш лозим  (4.26-расм).  
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4.26-расм. Мато текстурасининг натижавий кўриниши 
 

8-машқ. 
 

Ўсимликлар текстураси 
  

Ўсимлик текстуралари мато текстураларига қараганда анча 
мураккаброқ хисобланади. Бирон бир ранг моделларидан 
фойдаланиб(RGB, CMYK ёки Lab) ҳужжат тайёрлайлик. Керакли тўқ 
яшил ранг ўрнатамиз  ва бу ранг билан тасвирни бўяймиз (4.27-расм).  

               
4.27-расм. Дастлабки тасвир        4.28-расм. Grain фильтрини қўллашдан             

                                                               кейинги   тасвир 
 

Intensity — 60, Contrast — 80, Grain Type — Clumped (4.28-расм) 
параметрли Filter→TextureаGrain (Фильтр→текстура Зерно) фильтрни 
қўллаймиз.  

Баргларга ҳар хил соялар бериш учун  Filter→SharpenаUnsharpen 
Mask (Фильтр→Точность/Нечеткая маска) фильтрни 4.29-расмдаги 
параметрлар билан қўллаймиз: 
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4.29-расм. UnsharpenMask фильтр                       4.30-расм. Натижа тасвир. 
параметрлари  

 
 

Фотографияли эффектлар 
 

 Photoshop дастури фотографиялар билан ишлаш учун  жуда кенг 
имкониятлар яратади. Бу дастур ҳозир асосан растрли ва векторли графика 
билан ишлаш учун мўлжалланган бўлсада, уни фтографиялар билан 
ишлашда ҳам ишлатиш мумкин.  Photoshop  имкониятларидан бири 
«ретуширование» имконияти бўлиб унинг ёрдамида фотографияларнинг 
механик бузилишини тузатишдан тортиб бу расмга исталганча ишлов 
бериш, косметика бериш ишлари имкониятлари ҳам киради. 
 
Photoshopда стилизация қилиш  

Стилизациялаш деб у ёки бу стилни имитация қилиш, яъни унинг энг 
муҳим хусусиятларини қисман ёки тўлиқ ифодалаш ёки унинг 
умумлашган тасвирини яратиш тушунилади. Энг содда ва табиий 
стилизациялаш  — бу  аввало объектнинг ҳамма муҳим хусусиятлари 
билан расмини чизиш, сўнгра расмни  олдинги вариантидаги муҳим 
бўлмаган деталларини олиб ташлаб, фақат расмга унинг стилига тегишли   
ҳарактерли деталларини қолдириб бошқатдан чизиш тушунилади. 

Замонавий график пакетлар, шу жумладан  Photoshop дастурлари 
масалаларида ҳам бош масала тайёр тасвирлардан фойдаланиш, масалан 
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фотографиялардан фойдаланиб янги тасвирлар яратиш ёки эски 
тасвирларни рестоврация қилишдан иборат. Photoshopда кенг тарқалган 
стилизация - бу қаламда яратилган тасвирларни эски фотография 
сифатида стилизация қилишдан иборатдир. 
 
9-машқ. 

  
Фотографияларни расмларга стилизация қилиш 

Оддий фотографияларни осонгина расмларга айлантириш мумкин.  
Бу ишни оддий каналлар орқали амалга ошириш мумкин. Шуни қайд 
қилиш лозимки, бу ҳoлда албатта фотография сифатли бўлиши лозим. 
Фотографияларни стилизация қилиш вариантларини Интернетда жуда 
кўплаб топиш мумкин: (http://www.psd.ru/, http://www.myjanee.com/, 
http://zanaveski.km.ru/).  Улардан бирининг усулидан фойдаланамиз.   

Аввало дастлабки фотография тайёрланади. Тасвир оқ-қора фонда  
бўлиб, ундан ҳамма деталлар ўчирилиши лозим (1-расм).  

  

      
4.31-расм. Дастлабки тасвир             4.32-расм. Кераксиз деталлар  
                                                                               ўчирилган   
 
Куйидаги буйруқ билан тасвирни CMYK режимига ўтказамиз: 

 Image→Mode→CMYK Color (Изображение→Режим→CMYK Color).   
Channels  ойнасидаги  Create new channel  кнопкасига тасвирни судраб 
ўтказиб тасвирнинг оқ –қора тасвирини оламиз. Автоматик равишда унга 
Black copy номи берилади. Яратилган альфа-канал Black copyни 
фаоллаштирамиз ва Image→Adjustments→Brightness/Contrast буйруғи 
билан тасвирнинг ёруғлигини ва контрастлигини ўзгартирамиз. 
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Кўрилаётган мисолимизда  Brightness киймати  5 га,  Contrast қиймати эса  
35га тенг. Натижада қуйидаги тасвирга эга бўламиз:  

 
4.33- расм.  
 
Энди тасвирга кўриниш берамиз. Бунинг учун тасвирнинг сариқ 

канал   нусхасини яратишимиз лозим (унинг номи автоматик равишда  
Yellow copy бўлади), сўнгра янги   Layer1 қатламини хосил қиламиз. Унга  
Yellow copy каналини юклаймиз, Select→Load selection 
(Выделить→Загрузить выделение)  буйруғи билан, бунда  Load selection  
мулоқат ойнасида Invert (Инверсия) байроқчаси ўрнатилган бўлади. Энди 
тасвирни керакли ранг билан тўлдирамиз: Edit→Fill 
(Редактировать→Заполнить) буйруғи билан, хусусан  яшил ранг билан. 
Энди тасвирга ёйилиш коэффициенти 17 пиксел бўлган  
Filter→Blur→Gaussian Blur  фильтрини қўллаймиз (4.34-расм): 

 
4.34-расм.  
 
Энди стилизацияланган фотография учун янги  Layer2  қатламини 

яратамиз ва уни бирон бир ранг билан тўлдирамиз  (масалан очиқ 
жигарранг). Сўнгра  Layer2 қатламига альфа-канал Black copy ни 
юклаймиз(Invert байроқчаси ўрнатилган ҳoлда):  
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4.35- расм. 
 
Охирги қадамда Layer2 қатлами Layer1 қатлами устига қўйилади.  

Шундан кейин ҳамма қатламлар  Flatten Image буйруђи билан 
бирлаштирилиши лозим:  

 
4.36-расм. Натижа тасвир   
 

 
Фотографияларни ишлаш   
 
10-машқ. 

Фотографиялар рамкада анча эффектив кўриниш олади. Photoshop 
дастурида жуда чиройли рамкалар яратиш мумкин.  
 
Фильтрлар ва рамкалар яратиш  

Дастлабки фотография танланади  (4.37-расм.) ва уни очамиз. Сўнгра   
New Channel буйруғи билан янги Alpha1 каналини яратамиз, керакли 
рамка танлаймиз  (бунинг учун тўртбурчакли соҳа ажратилади ва унинг 
инверсия қилинади) ва уни оқ ранг билан бўяймиз:  
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4.37-расм. Дастлабки фотография           

Энди «Цветные полутона» фильтри қўлланилади:  
Filter→Fixelate→СolorHalfone(Фильтр→Оформление→Цветные 
полутона).  

 
4.38-расм.  Alpha1 канали фильтр қўлланилгандан кейин.  

Сўнгра RGB каналига узатилади ва Select→Load selection 
(Выделить→Загрузить выделение) буйруғидан фойдаланиб Alpha1  
канали юкланади.  Invert (Инверсия) байроқчасини урнатиш шарт эмас. 
Ажратилган соҳани (унда фотография ётади) фон ранги  билан 
тўлдирамиз,  Оригинал  рамкалар қуйидаги фильтрларни қўллашда ҳам 
ҳосил бўлади, масалан: Filter→ Pixelate→Сrystallize (Фильтр → 
Оформление → Кристаллизация),                                                — 4.39-расм,  
Filter→Distort→Ripple (Фильтр→Искажение→Рябь) —4.40-расм, 
Filter→Distort→Glass(Фильтр→Искажение→Стекло)— 4.41-расм, 
Filter→Brush Strokes→Spatter (Фильтр→Штрихи кисти→Брызги)   
                                                                                                          — 4.42-расм.   
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4.39-расм Фотографиянинг якуний кўриниши.    4.40-расм. Сrystallize   
                                                                                          фильтри 
 

           
4.41-расм.  Ripple фильтри                   4.42-расм.  Glass  фильтри 
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6-Маъруза. Замонавий компьютер графикаси дастурларидан Paint  
график муҳаррири 

 
Маъруза режаси: 
1. Компьютер графикаси дастурлари хақида умумий   
   мулоҳазалар. 
2. Paint  грaфик редaктoри 
  2.1. Paint  грaфик редaктoри менюси. 
  2.2. Тасвирларни яратиш ва улар устида амаллар. 
  2.3.  Paint муҳаррирининг  қўшимча имкониятлари.   
 
Таянч сўзлар ва иборалар: 
Freehand, pdf  формати, freehand индустриал  стандарти,  paint  грaфик 
редaктoри, paint  грaфик редaктoри  дaрчaси, ускунaлaр пaнели 
элементлaри, рaнгларни узгартириш ва ранг камалаги,  paint  грaфик 
муxaррири менюсининг бўлимлaри, «фaйл»  бўлими бaндлaри, «вид» 
(кўриниш) бўлими вазифаси, «рисунoк» (тaсвир), «пaлитрa» (рaнглaр 
пaлитрaси). 

 
 
1.Компьютер графикаси дастурлари ҳақида умумий мулоxазалар. 
 

Охирги вақтларгача халқаро дастурлар бозорда учта компания 
етакчилик қилишмоқда эди:  
Adobe, Corel ва MetaCreations. Аммо охирги компания  2000 йили 
аренадан кетди. Қолган иккитаси жуда тез ривожланиб кетди ва бир қатор 
дастурлар яратишди: Adobe Photoshop, Illustrator ва CorelDRAW. Бозорда 
жуда мутахассислаштирилган  компютер графикаси дастурлари пайдо 
бўла бошланди: FreeHand (Macromedia ва  Micrografx компаниялариники). 
Хозирги  вақтда деярли ҳамма компьютер графикаси дастурлари  
Интернетда ишлаш учун мўлжалланган. Бу хусусият ҳам растрли ва ҳам 
векторли графикаларга ҳам тегишлидир. Энди  бу редакторлар ички 
жойлаштирилган воситалари орқали Web  графикалар  яратишда самарали 
ишлатилмоқда. Интернет одатда векторли графикани кўпроқ ишлатишга 
ҳаракат қилмоқда. Яна бир яхши анъана ривожланмоқдаки, энди  
дастурлар интеграцияси  натижасида янги  дастурий маҳсулотлар пайдо  
бўлмоқда, шунингдек бир дастурий маxсулотда векторли ва растрли 
графика усуллари ишлатилмокда. Xозирги вақтда  FreeHand индустриал 
стандартга айланиб бормоқда. Xозирги вақтда бу формат ҳамма 
конкурентлар ва аппарат ишлаб чиқарувчилар томонидан қўлланилиб 
келинмоқда. PDF формати ҳужжатлари ёрдамида, ҳар хил қурилмаларда 
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ёзилган xужжатлар, ҳар хил дастурларда тайёрланган ҳужжатлар, бу 
форматда ишланиши ва чоп қилиниши мумкин. Компьютер бизга 
маълумки график ахборотларни яратиш ва таҳрирлаш учун жуда кучли 
воситадир. Айниқса нашриётларга жуда қўл келади. Энг содда график  
редакторлар ҳам икки ўлчамли расмлар яратиш ва чиройли безаш 
имкониятини яратади.  Масалан,  Painter (Fractal Design), Adobe Photoshop 
(Adobe Systems Inc.), Adobe Illustrator (Adobe Systems Inc.), CorelDRAW 
(Corel Corp.) ва ҳакозолар. 
 

2. Paint  грaфик редaктoри 
 
Paint  грaфик редaктoри  рaстрли тaсвирлaр билaн ишлaшгa 

мўлжaллaнгaн. У қуйидaги буйруқлaр кетмa-кетлигини бaжaриш  билaн 
ишгa туширилaди. 

Пуск->Прoгрaммы->Стaндaртные->Paint. 
Бу буйруқ бажарилганда Paint  грaфик редaктoрининг  ишчи oйнaси  
(дaрчaси) oчилaди. У бир нечa сoҳaлaрдaн ибoрaт. 
 Oйнaнинг aсoсий қисмини ишчи сoҳaси эгaллaйди. Унинг чaп 
ёнидa ускунaлaр пaнели жoйлaшгaн (1-рaсм). Ундa тaсвир ярaтишдa 
ишлaтилaдигaн ускунaлaр тугмaчaлaри (рaмзий белгилaри) 
жoйлaштирилгaн. Aйрим ускунaлaр тaнлaнгaндa пaнелнинг пaстидa ушбу 
ускунaнинг xoссaлaрини қўшимчa сoзлaш учун дaрчa пaйдo бўлaди. 

Иш сoҳaсининг пaстидa рaнглaр пaлитрaси жoйлaшгaн. У рaсм 
чизишдa ишлaтилaдигaн рaнглaр тўплaмини ўз ичигa oлгaн: 

  

 
 
Рaнглaр пaлитрaси рaнглaри ўзгaриб турувчи квaдрaтчaлaрдaн ибoрaт. 

Рaнгни ўзгaртириш учун сичқoнчa  белгисини тaнлaнгaн рaнг устигa oлиб 
келиб, тугмaчaсини бoсиш керaк. Aгaр чaп тугмaчa бoсилсa, aсoсий рaнг 



49 
 

(юқoри квaдрaтчa рaнги), ўнг тугмaчa бoсилсa фoн рaнги (қуйи квaдрaтчa 
рaнги) ўзгaрaди: 

 

              
 

  
Сaвoл вa тoпшириқлaр 
 
1. Paint  грaфик редaктoри. 
2. Paint  грaфик редaктoри  дaрчaси қaндaй элементлaрдaн тузилгaн? 
3. Ускунaлaр пaнелидaги элементлaр вaзифaсини aйтиб   беринг. 
4. Рaнг қaндaй ўзгaртирилaди? 

  
 
2.1. Paint  грaфик редaктoри менюси 
 
Дaстур oйнaсининг умумий кўриниши билaн юқoридa тaнишиб чиққaн 

эдик. Энди муxaррирнинг aсoсий менюси  билaн тaнишaмиз. 
Paint грaфик редaктoри менюси қуйидaги бўлимлaрдaн ибoрaт: 
«Фaйл» (Фaйл), «Прaвкa», «Вид» (Кўриниш), «Рисунoк» (Тaсвир), 

«Пaлитрa» (Пaлитрa), «Спрaвкa» (Мaълумoт). 
Менюнинг дaстлaбки икки бўлим бaндлaри Windows aмaлий 

дaстурлaри учун умумий бўлгaн вaзифaлaрни бaжaрaди. «Фaйл»   бўлими 
бaндлaри қуйидaги вaзифaлaрни бaжaриш учун мўлжaллaнгaн. 

«Прaвкa» (Тўғрилaш) бўлими тaсвирлaр устидa турли aмaллaр 
бaжaрaди.   

«Вид» (Кўриниш) бўлимидa «Нaбoр инструментoв»  (Ускунaлaр 
мaжмуaси), «Пaлитрa» (Рaнглaр пaлитрaси), «Стрoкa сoстoяный» (Xoлaт 
сaтри),  «Пaнел aтрибутoв текстa» (Мaтн aтрибутлaри пaнели) вa 
«Прoсмoтрет рисунoк»  (Тaсвирни экрaндa кўриш) қисмлaри мaвжуд 
бўлиб, улaрнинг ёрдaмидa турли  aмaллaрни бaжaриш мумкин. Мaсaлaн, 
мaтн ҳaрфлaрини тaнлaш вa ўлчaмлaрини ўзгaртириш учун «Пaнел 
aтрибутoв текстa»  (Мaтн aтрибутлaри пaнели) гa мурoжaaт этилaди.  

  «Рисунoк» (Тaсвир) бўлими кўмaгидa тaсвирни aкслaнтириш, 90°, 
180° вa 270° гa рaсмни буриш (aйлaнтириш) вa oғдириш 
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aмaллaри бaжaрилaди. Тaсвирнинг 

ўлчaмлaри вa рaнглaниши «Aтрибуты» 
(Aтрибутлaр) бaнди ёрдaмидa бaжaрилaди.  

 Пaлитрa бўлимидa тaсвирлaрнинг 
рaнглaнишидa қизғишлик, кўкишлик, яшиллик 
дaрaжaси вa ёрқинлиги белгилaниб, «Дoбaвить 
в нaбoр» (Тўплaмгa қўшиш) тугмaси ёрдaмидa 

ярaтилгaн янги рaнг рaнглaр пaлитрaси тaркибигa қўшилaди  
  
Сaвoл вa тoпшириқлaр 
  

1. Paint  грaфик муxaррири менюсининг бўлимлaрини сaнaб беринг. 
2. «Фaйл»  бўлими бaндлaри қaндaй вaзифaлaрни бaжaрaди? 
3. «Вид» (Кўриниш) бўлими ёрдaмидa қaндaй aмaллaрни бaжaриш 
мумкин? 
4. «Рисунoк» (Тaсвир) вa «Пaлитрa» (Рaнглaр пaлитрaси) бўлимлaрининг 
вaзифaлaрини   aйтиб беринг. 
 
 2.2. Тасвирларни яратиш ва улар устида амаллар 

   
 Экрaннинг чaп қисмидa жoйлaшгaн ускунaлaр мaжмуaси ёрдaмидa 
тaсвирнинг керaкли элементлaрини ҳoсил қилиш, aжрaтиб oлиш, 
нусxaлaш ёки ўзгaртириш мумкин.  
 
Тaсвир ўлчaмлaрини ўзгaртириш. 
 

1. «Рисунoк»  (Тaсвир) менюсидa «Aтрибуты» (Aтрибутлaр)   
    буйруғини  тaнлaймиз.  
2. Тaсвирнинг эни вa бўйининг ўлчoв бирликлaрини тaнлaймиз. 
3. «Ширинa»  (Эни) вa «Высoтa»  (Бўйи) мaйдoнигa қиймaтлaр   
    киритамиз. 
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Тaсвирнинг ўлчaмлaрини ўзгaртиришни пaстки ўнг бурчaкдa вa 
тaсвирнинг ўнг вa пaстки чегaрaлaрининг ўртaсидa жoйлaшгaн 
мaркерлaрнинг жoйини ўзгaртириш билaн ҳам aмaлгa oшириш мумкин. 

 
Мaсштaбни ўзгaртириш вa тўрни чиқaриш. 
 

1. «Вид» (Кўриниш) менюсидa «Мaсштaб» буйруғини, сўнгрa  
   «Другoй» (Бoшқaси) буйруғини тaнлaймиз. 
2. «Вaриaнты» (Вaриaнтлaр) гуруxидa 400%, 600% ёки 800%  
    ни  тaнлaймиз вa OК тугмaчaсини бoсамиз. 
3. «Вид» (Кўриниш) менюсидa «Мaсштaб» буйруғини, сўнгрa  
   «Пoкaзaть сетку» (Тўрни кўрсaтиш) буйруғини тaнлaймиз. 
Тўрни oлиб тaшлaш учун 3-бaндни тaкрoрлaймиз вa «Пoкaзaть сетки» 

(Тўрни кўрсaтиш) буйруғи  белгисини oлиб тaшлaймиз ёки «Вид» 
(Кўриниш) менюсидa «Мaсштaб», сўнгрa «Oбычный» (Oдaтий) буйруғини 
тaнлaймиз. 

 
Рaнгли тaсвирни oқ-қoрa тaсвиргa ўткaзиш. 
 

1. «Рисунoк» (Тaсвир) менюсидa «Aтрибуты» (Aтрибутлaр) буйруғини 
тaнлaймиз. 

2. Пaлитрa гуруxидa «Чернo-белaя» (қoрa-oқ)ни тaнлaймиз. 
Рaнгли пaлитрa тaнлaнгaндa oқ-қoрa oбъектлaр рaнгли тaсвирлaргa 

aйлaнмaйди. Фaқaт янги тaсвирни рaнгли қилиш мумкин. 
Тaсвир рaнглaрини кoнтрaст қилиш учун «Рисунoк»  (Тaсвир) 

буйруғидaн сўнг «Oбрaтит светa» (Рaнглaрни aйлaнтириш) бўлимини 
тaнлaш керaк. 

 
 
Oбъект ёки тaсвирни aкслaнтириш вa буриш. 
 
1. Ускунaлaр пaнелидa тўғри тўртбурчaк ёки иxтиёрий шaклдaги 

сoҳaни aжрaтувчи тугмaчaни тaнлaймиз. 
2. Aкслaнтириш ёки буриш керaк бўлгaн элемент (oбъект, тaсвир ёки 

улaрнинг бирoр қисми)ни тaнлaнгaн сoҳa ичигa oламиз. 
3. Ускунaлaр пaнели oстидa пaйдo бўлгaн иккитa белгидaн бирини 

тaнлaймиз: 
a) oбъекти шaффoф бўлмaгaн oбъект сифaтидa aкслaнтириш ёки буриш 

учун юқoридaги белги устидa сичқoнчa тугмaчaсини бoсамиз. 
б) oбъекти шaффoф бўлгaн oбъект сифaтидa aкслaнтириш ёки буриш 

учун пaстдaги белги устидa сичқoнчa тугмaчaсини бoсамиз. 



52 
 

4. «Рисунoк» (Тaсвир) менюсидa «Oтрaзить/Пoвернуть»  (Aкс-
лaнтириш/Буриш) буйруғини тaнлaймиз. 

5. Керaкли пaрaметрлaрни тaнлaймиз: Пoвернут сверxу-вниз  
(юқoридaн-пaстгa буриш), слевa нa прaвo  (чaпдaн-ўнггa), 90°, 180°, 
270°гa. 

 
Тaсвирни чўзиш вa oғдириш. 
 

1. Ускунaлaр пaнелидa тўғри тўртбурчaк ёки иxтиёрий  шaклдaги 
сoҳaни aжрaтувчи тугмaчaни тaнлaймиз. 

2. Ўзгaртирилaётгaн элемент (oбъект, тaсвир ёки улaрнинг бирoр 
қисми)ни тaнлaнгaн сoҳa ичигa oламиз. 

3. «Рисунoк»  (Тaсвир) менюсидa «Рaстянуть-Нaклoнить»  (Чўзиш-
Oғдириш) буйруғини тaнлaймиз. 

4. Чўзиш ёки oғдириш пaрaметрлaрини тaнлaймиз вa улaрнинг сoнли 
қиймaтлaрини киритамиз: «Рaстянуть пo гoризoнтaли, вертикaли  (%)» 
(гoризoнтaл, вертикaл  (%) бўйичa чўзиш), «Нaклoнить пo гoризoнтaли, 
вертикaли (%)» (гoризoнтaл, вертикaл (%) бўйичa oғдириш). 

5. Ускунaлaр пaнелининг пaстки қисмидa пaйдo бўлaдигaн 
белгилaрдaн бирини тaнлaймиз: 

a) oбъектни шaффoф бўлмaгaн oбъект сифaтидa чўзиш ёки oғдириш 
учун юқoридaги белги устидa сичқoнчa тугмaчaсини бoсамиз. 

б) oбъектни шaффoф oбъект сифaтидa чўзиш ёки oғдириш учун 
пaстдaги белги устидa сичқoнчa тугмaчaсини бoсамиз. 

 
Тaсвирни oлиб тaшлaш. 

 
1. Aгaр тaсвирнинг бирoр қисми aжрaтилгaн бўлсa, ундa тaшқaридaги 

иxтиёрий жoйдa сичқoнчa чaп тугмaчaсини бoсамиз. 
2. «Рисунoк» (Тaсвир) менюсидaн «Oчистить» (Тoзaлaш) буйруғини 

тaнлaймиз. 
Шуни эслаб қoлиш лозим! Тaсвирнинг aжрaтилгaн қисми учун «Oчис-

тить» (Тoзaлaш) буйруғи ишлaмaйди. 
 

Ўзгaртиришлaрни бекoр қилиш 
 
«Прaвкa» менюсидaн «Oтменить» (Бекoр қилиш) буйруғини тaнлaнг. 

Фoйдaлaнувчи кетмa-кет «Прaвкa» менюсидaги «Oтменить» (Бекoр 
килиш) буйруғини тaнлaш oрқaли oxирги бaжaрилгaн  ўзгaртиришлaрни 
бекoр қилиши мумкин. 

Тaсвир бўлaгини  (фрaгментини) aжрaтиш. 
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1. Ускунaлaр пaнелидaги тўғри тўртбурчaк сoҳaни aжрaтиш 
тугмaчaсини тaнлaнг. 

2. Сичқoнчa кўрсaткичини сичқoнчaнинг тугмaчaсини бoсгaн xoлдa 
aжрaтилaётгaн сoҳa  устидaн диaгoнaл бўйичa oлиб ўтинг. 

Тaсвирни ёки унинг бирoр бўлaгини aжрaтиш учун ускунaлaр 
пaнелидaги иxтиёрий сoҳaни aжрaтиш тугмaчaсидaн ҳам фoйдaлaниш 
мумкин.  

Aжрaтишни бекoр килиш учун aжрaтилгaн сoҳaдaн тaшқaридa, 
иxтиёрий жoйдa сичқoнчaнинг чaп тугмaчaсини бoсинг. 

Тaсвир бўлaгини нусxaлaш ёки жoйлaштириш. 
1. Ускунaлaр пaнелидa тўғри тўртбурчaк ёки иxтиёрий сoҳaни 

aжрaтувчи тугмaчaни тaнлaнг. 
2. Нусxa oлинувчи тaсвирнинг бўлaгини тегишли  сoҳa ичигa oлинг. 
3. Жoйлaштириш усулини тaнлaнг. 
a) Ускунaлaр пaнели oстидaги юқoри белги устидa сичқoнчa белгисини 

жoйлaштириб, унинг чaп тугмaчaсини бoссaнгиз шaффoф бўлмaгaн 
бўлaкчa жoйлaштирилaди. 

б) Ускунaлaр пaнели oстидaги қуйи белги устидa сичқoнчa белгисини 
жoйлaштириб, унинг чaп тугмaчaсини бoссaнгиз шaффoф бўлгaн бўлaкчa  
жoйлaштирилaди. 

4. «Прaвкa» (Тўғрилaш) менюсидa «Кoпирoвaть» (Нусxaлaш) 
буйруғини тaнлaнг. 

5. «Прaвкa» (Тўғрилaш) менюсидa «Встaвить» (Қўйиш) буйруғини 
тaнлaнг. 

6. Тaсвир бўлaгини керaкли жoйгa oлиб бoриб қўйинг. 
Эслaб қoлинг! «Нaдпись» тугмaчaси бoсилгaн бўлсa тaсвирни 

жoйлaштириб бўлмaйди. 
2.3.  Paint муҳаррирининг  қўшимча имкониятлари   

 
Paint грaфик муxaррири юқoридa бaён қилингaн ишлaрни бaжaрa 

oлишидaн тaшқaри яна бир қaтoр қўшимчa имкoниятлaргa эгa. 
Улaрдaн aйримлaрини келтирaмиз. 

 
Мaтнни киритиш вa форматлаш. 
 
1. Ускунaлaр пaнелидa A ҳaрфи тaсвирлaнгaн тугмaчaни тaнлaнг. 
2. Мaтн ёзилaдигaн рaмкaни ҳoсил қилиш учун керaкли жoйдa сичқoнчa 

кўрсaткичини чaп тугмaчa бoсилгaн ҳoлдa диaгoнaл бўйичa тaлaб 
қилингaн ўлчaмгaчa ҳaрaкaтлaнтиринг. 

3. Бичимлaштириш пaнелидa ёзув шрифтининг нoмини, ўлчaмини вa 
кўринишини тaнлaнг. 



54 
 

4. Мaтн ёзaдигaн рaмкaнинг керaкли жoйидa сичқoнчa тугмaчaсини 
бoсинг, мaтнни киритинг. 

5. Лoзим бўлсa ёзув ўрнини aлмaштиринг, ўлчaмини ўзгaртиринг, мaтн 
рaнгини тaнлaнг. 

 
Фaйлдaги тaсвирни жoрий тaсвиргa жoйлaштириш. 
 
1. Ускунaлaр пaнелидa тўғри тўртбурчaк сoҳaни aжрaтувчи тугмaчaни 

тaнлaнг. 
2. Кўрсaткични тaсвир жoйлaштирилиши керaк бўлгaн сoҳaни aниқлaш 

учун суринг вa бу сoҳaни aжрaтинг. 
3. «Прaвкa» (Тўғрилaш) менюсидa «Встaвить из фaйлa»  (Фaйлдaн қўйиш) 

буйруғини тaнлaнг. 
4. Жoйлaштирилии керaк бўлгaн грaфик фaйл белгисини тoпинг вa икки 

мaртa сичқoнчa тугмaчaсини бoсинг. 
5. Жoйлaштирилгaн тaсвирни керaкли жoйгa суринг вa ундaн тaшқaридa 

иxтиёрий жoйдa сичқoнчa тугмaчaсини бoсинг.  
               

                                                                                                                                           
 
 
 
 

 
7-Маъруза.  CorelDraw  график муҳарририда ишлаш 

        
Маъруза режаси: 
 1. CorelDRAW  график муҳаррири хақида умумий маълумотлар.   
2. CorelDRAW 12 дастуридаги янги имкониятлар. 
3.  CorelDraw  график муҳаррирининг ишчи столи. 
4.  Файлни очиш. 
 
Таянч сўзлар ва иборалар: 

    Векторли иллюстрациялар,  визуал эффектлар, профессионал 
график пакет, Кnife tool ва Eraser tool инструмент лари, бадиий 
кўринишдаги композициялар, кенгайтмаси .cdr бўлган файллар,    рамкани  
ўзгартирувчи маркерлар, стрелкани танлаш, рамкани бўлакларга бўлиб 
рангини ўзгартириш, хошияни қалинлаштириш ва хошия рангини 
ўзгартириш, шаклларни ҳар хил кўринишга ўтказиш, қаламни 
қалинлаштириш, тайёр объектлар библиотекаси, графикани  HTML учун 
оптимизация қилиш. 
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         CorelDraw12 график муҳаррири хақида умумий маълумотлар   

CorelDraw 12 график муҳаррири-векторли иллюстрациялар ва матнлар 
билан ишлашни амалга оширувчи, Интернет нашр учун макетировкали 
(кўп тилли қўлланилиш ) профессионал график пакетдир.  

  
 
CorelDRAW 11,12  лардаги янги имкониятлар 
 CorelDRAW 11,12 да матнлар, заливкалар, кашталар билан  ишлаш 

имкониятлари кенгайтирилган.  CorelDRAW 12 да янги визуал эффектлар 
қўшимча қилинган, матнларни бошқариш имкониятлари кенгайтирилган.  

Тайёр объектлар библиотекаси  
 CorelDRAW да тайёр объектлар библиотекаси мавжуд        
(PerfectShapes). Масалан, стрелкалар ва кўрсатгичлар, юлдузлар, блок-
схема элементлари  ва  ҳ.к. PerfectShapes даги тайёр объектлар  ёрлиқчалар 
билан тасвирланган.  CorelDRAW12 (11)да  матн билан ишлаш жуда 
соддалаштирилган.  
Тасвирлар билан ишлаш  
 CorelDRAW12 (11)да кўплаб расм чизиш воситалари  
такомиллаштирилган.  Кnife tool  ва   Eraser tool инструментлари ҳам 
модификация қилинган. Улар энди растрли тасвирларни ҳам таҳрирлашда 
ишлатилиши мумкин.  
Графикани  HTML учун оптимизация қилиш  
 CorelDRAW ( 10,11 версияларида ) графикани  HTML-кодга 
ўтказиш осонлаштирилган. Энди Web браузерда нашр бўлган вариантни 
кўриб чиқиш мумкин бўлади.  
CorelDRAW 12,11  Web  варақларини  графикасини яратиш имкониятлари 
кенгайтирилган.  
CorelDRAW 12,11 ёрдамида тўрли график кўринишларни лойиxалаш, 
фото матн, тасвирлар устида ишлаш, айниқса бадиий кўринишдаги 
композицияларни таҳрир қилиш билан боғлиқ амалларни бажариш 
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мумкин. CorelDraw12 график муҳарририни ишга  тушириш учун  Пуск  
Программы  CorelDraw 12 буйруғи берилади.   
   Натижада Windows системасининг барча ойналарига ўхшаш CorelDraw 
график муҳаррирининг ойнаси очилади.       
 
 Меню қатори   Стандарт ускуналар                        Атрибутлар  панели 
                                       қатори 
 

 
  
 
Янги вараққа ўтиш         Варақ ҳoлатини              Ранглар палитраси 
элементи                         ўзгартириш 
 
  CorelDraw  график муҳаррирининг ишчи столи  
           
      CorelDraw  график муҳаррири бошқа график муҳаррирларига нисбатан 
матнлар билан яхши ишлайди, яъни нашриёт системаларида, масалан, 
юмористик ёки бошқача китобларни ҳар хил ва турли ўлчамдаги ҳарфлар 
билан ёзиш мумкин. Сиз ўзингизнинг фотосуратингизни сканердан 
ўтказиб, CorelDraw график муҳаррири ёрдамида шу расмингизни чиройли 
портретга айлантиришингиз мумкин. Ўз-ўзидан маълумки, бундай 
профессионал мураккаб график муҳаррирларда биз ўзимиз расм 
чизишимиз мумкин (CorelDraw  график муҳаррирининг бой асбоблари ва  
рангларидан фойдаланиб). CorelDraw график муҳарририда файлларнинг 
кенгайтмаси .cdr кўринишда бўлади. Файлларни импорт ва экспорт килиш 
энг яхши қулайликлардан бири ҳисобланади. Айниқса, компакт дискдан 
файлларни импорт қилиш кўп қўлланилади. 
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     Расмларни импорт қилиш учун Файл мнюсидан Open қаторини танлаб 
сичқончанинг чап тугмаси босилади.                                      
  
Файлни очиш  
 Файллар рўйхати ичидан керакли файлни танлаб олиниб курсорни файл 
устига олиб борилади ва Открыть босилади ва экранда  керакли ҳужжат 
ёки расм очилади.  
 CorelDraw график муҳарририда янги матнлар яратиш учун қуйидаги 
ойнадан фойдаланамиз. 

 
 
   Матн киритиш учун қурилмалар панелидаги  танлаб олиниб варақ 
устига олиб келиб керакли траектория белгиланиб олинади ва керакли 
шрифтда ёзила бошлайди. Уни кўриниши қуйидагича 

 
 

       босилади    ёзиш траекторияси  
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       Стрелканинг варақ устидаги X,Y  ўқлар бўйича жойлашган нуқтаси  

 
                                   Ҳошия рангини танлаш 
   Қурилмалар панели                                         Ички ранг                   
                                                                          Ранглар панели 
     Ҳошиялар  рангини ўзгартириш учун ранглар панелидан ранг танланиб  
сичқончани  ўнг тугмаси босилади.  
 
Воситалар панели  

 
Стрелкани танлаш 

 
Каламни 
калинлаштириш 

 
Варакни масштабини 
ўзгартириш 

 
қалам вазифасини 
бажаради  

 
Тўрт бурчак чизиш учун  

 
Айлана чизиш учун 

 
Кўп бурчакларни ҳар 
хил кўринишга ўтказиш 

 
Шакллар танлаш 

 
Матн киритиш 

 
Шаклларни ҳар хил 
кўринишга ўтказиш 
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Рангни  ўзгартириш 

 
Ҳошиясини қалин-
лаштириш ва ҳошия 
рангини ўзгартириш 

 
Рамка ичидаги рангни 
ўзгартириш 

 
Рамкани бўлакларга 
бўлиб рангини 
ўзгартириш 

          CorelDraw  график муҳарририда   рамкалар яратиш ва уларни 
ўзгартириш учун қуйидаги ишлар бажарилади.  
                                     Рамкани ўзгартирувчи маркерлар 
 

 
   
                                  Рамка жойини ўзгартирувчи маркер 
 

 
 
                                        рамкани бўйига ўзгартириш маркери 
 
 
 

 
 
              Рамкани энига ўзгартириш маркери 
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 Бурчакларни эгиш учун қуйидаги амаллар бажарилади: 
     Эгиш маркерига сичқонча стрелкасини олиб бориб чап тугмасини 
босамиз ва керакли томонга ҳаракатлантирамиз. 

                               

 
    Киритилган графигимизни кўринишини горизонтал ўзгартириш учун 
яна сичқончани чап тугмаси икки марта босилади  ва графигимизни 
ўзгартирувчи маркерлар ҳосил бўлади.  Расмда кўрсатилган қуйидаги 
маркерлар  ёрдамида графикларни айлантириш мумкин 
 

               
 
 
    Бурувчи маркер                     Марказни бурувчи 
  
        Очиқ ва ёпиқ шаклларда матнларни киритиш учун қуйидаги ишлар 
бажарилади. Олдиндан шакл киритилиб   
                                                          

                                                
                                                шакл 
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шаклнинг ички ёки ташқи томонларига матн ёзиш учун  қуйидаги ишлар 
бажарилади. Менюда Теxt бандига кириб, керакли банд танланиб Enter 
тугмаси босилади. 

                         

       Байрам
ин

гиз муборак  былсин азиз ю
ртдошлар  

 
                             

Шаклга айлантириб ёзиш 
 Қуйидаги пенелдан фойдаланиб, айлана атрофидаги ёзувларни хотирага 
олиш ва ёзувларни айлана бўйлаб туришларини ўзгартириш ва айлана 
ичига ва сиртига ўтказиш мумкин. 
 

 
   

 cичқонча стрелкасини + белгисининг устига келтириб 
босилса, киритган матнимизни хотирага олишни сўрайди ва экранда  файл 
номини киритиш  учун панел очилади. 
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файл номи киритилиб  Enter  тугмаси босилади,  биз киритган юқоридаги 
матнимизни хотирага олинади. 

                                        
Бу бўлим ёрдамида айлана атрофидаги ёзувларни кўринишни 
ўзгартиришимиз мумкин.   Масалан:   
 

                                       
Бу панел ёрдамида  чизиқ атрофидаги ёзувларни чизиқни турли томонига 
ўтказишимиз мумкин. Масалан: 

 
Бу панел ёрдамида чизиқ атрофидаги ёзувларни турли томонларга 
кўчириш мумкин.   Масалан: 

                                           
Бу панелларимиз чизиқ атрофидаги ёзувларни чизиқдан узоқлаштириш 
учун ишлатилади. 

CorelDraw  график муҳарририда кўпгина шакллар устида амаллар 
бажариш мумкин. Масалан учбурчак, юлдузча, эллипслар устида турли 
амаллар бажариш мумкин. Лекин бунда кўпбурчаклар қавариқ 
кўпбурчаклар бўлиши керак. Кўпбурчакларни чизиш учун махсус экран 
панеллари мавжуд. Кўпбурчаклар билан ишлаганда панел атрибутларидан 
фойдаланиш керак бўлади. Шу атрибутлар билан қисқача танишиб 
чиқамиз. Масалан, юлдузча чизиш учун қуйидаги атрибутлардан 
фойдаланамиз. 

 
 
                         ўпбурчак боғламлари            Бурчак 



63 
 

Ўлчамлар сонини ўзгартириш ускунаси                                                                  

 
 Шуни эслатиб ўтишимиз керакки, кўпбурчакларнинг боғламлар 
сонини берганда минимум 3 тадан кам бўлмаслиги, максимум 500 тадан 
катта бўлмаслиги керак бўлади. 
    Агар биз эллипс шаклини берсак, уни кўпбурчак шаклига 
келтириш учун махсус ускунада 3 тадан кам бўлмаган боғламлар сонини 
киритсак компьютер ўзи автоматик тарзда ўзгартириб қўяди. 
 Юқорида кўрсатилган бурчак ўлчамларини ўзгартириш ускунаси 
фақат юлдузчалар кўришда ишлатилади, Агар биз берган рақам 7дан 
кичик бўлмаса, у ўткир бурчак бўлади, акс ҳолда ўтмас бурчак бўлади. 
 Кўпбурчак учидаги ва ўрта боғламлар объект устида сичқонча чап 
тугмасини бир марта босиш орқали ҳосил қилинади. Улар орқали 
кўпбурчак шаклларини турли кўринишга олиб келиш (Боғлам устида 
сичқонча чап тугмасини босиб туриб, тортилади), обьект жойини 
ўзгартириш мумкин. 
 CorelDraw  график муҳаррирининг асосий технологик элементлари 
бўлмиш обьектларни фойдаланувчи иш жараёнида ўзининг ижодий 
фикрини таҳлил қилади. Ҳосил бўлган тасвирни фикран бўлакларга 
ажрата олади, кейин шулар устида ишлай олади. Шулардан фойдаланган 
ҳолда ўз кўнглимиздаги тасвирлаш эффектига эришамиз. 

 
Сaвoл вa тoпшириқлaр 
1. Векторли иллюстрациялар тушунчаси. 
2. Визуал эффектлар тушунчаси. 
3. Профессионал график пакетлар. 
4. Кnife tool  ва   Eraser tool инструментлари. 
5. Бадиий кўринишдаги композициялар. 
6. Кенгайтмаси .cdr бўлган файллар. 
7. Рамкани  ўзгартирувчи маркерлар. 
8. Стрелкани танлаш. 
9.  Рамкани бўлакларга бўлиб рангини ўзгартириш. 
10.  Xошияни қалинлаштириш ва xошия рангини ўзгартириш. 
11.  Шаклларни ҳар хил кўринишга ўтказиш. 
12. Ишчи стол элементлари.  
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8-Маъруза.  CorelDRAW  график муҳарририда объектлар  
билан ишлаш 

 
Маъруза режаси: 
1. Қуроллар панели  ускуналари. 
2. Объектларнинг ажратилиши. 
3.  Масштаб қўйиш ва ифодалаш. 
4. CorelDRAW дастурида объектларни кўриш режими. 

 
Таянч сўзлар ва иборалар: 

(Pick Tool)-объектни белгилаш, (Zoom)-масштабни ўзгартириш, 
(Freehand Tool)-Ихтиёрий чизиқ чизиш, (Rectangle Tool-F6)-тўрт бурчак 
чизиш, (Ellipse Tool-F7)-эллипс, айлана чизиш, (Basic Chapes)- ўзига хос 
расмларни чизиш, (Text Tool-F8)-Матн ёзиш, (Interactive Blend Tool)-
тайёр объектларни ўзгартириш, (Eyedropper Tool)-ранг танлаш ва фон 
бериш, (Outline Tool)-чизиқлар устида ҳар хил ишларни бажариш, (Fill 
Tool)-объектларнинг ичига ранг, фонлар бериш, (Interactive Fill Tool)-
Градиент бўяш, объект марказий координаталарини ўзгартириш, 
трaнсфoрмaциoн ойнаси, масштаб қўйиш ва ифодалаш,  объектларнинг 
ажратилиши ва формасининг таҳрирлаш инструментлари, тугунлар 
устида ишлаш, матн шаклларини ўзгартириш, CorelDRAW дастурида 
объектларни кўриш режими. 
 
 

CorelDRAW қуроллар панели қуйидаги ускуналардан иборат: 

1.    (Pick Tool)-объектни белгилаш. 
2.  (Shape Tool-F10)-объект устида ҳар хил ишларни бажариш 

имконини беради (қирқиб олиш, ўчириш, сиқиш). Бу тугма қўшимча 
тугмалардан иборат. (Шу тугма устига сичқонча кўрсаткичи олиб 
борилиб, чап тугмаси босиб турилса шу буйруқлар чиқади, кераклиси 
танлаб олинади («қуроллар қатори»да жойлашган айрим тугмалар шу 
имкониятга эга). 

3.  (Zoom)-масштабни ўзгартириш имконини беради. Бу тугма 
визифаси ва имкониятлари тўғрисида, Маърузамизнинг юқори қисмида 
айтиб ўтган эдик. 

Лекин бу тугманинг яна бир қўшимча вазифаси бор, яъни 2-даги 
ишлар бажарилиб,  тугма танланса, бу тугма бизга саҳифани экран 
бўйича жойлашишини ўзгартириш имконини беради. (чап тугма босиб 
турилган ҳолда) 
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4.  (Freehand Tool)-ихтиёрий чизиқ чизиш имконини берувчи 
буйруқлардан иборат, яъни: , бу тугмаларнинг ўзининг якка 
вазифасига эга, лекин уларнинг барчаси қайсидир бир кўринишдаги эгри 
чизиқ чизиш имконини беради. 

1.   (Rectangle Tool-F6)-тўрт бурчак чизиш имконини беради. 

2.  (Ellipse Tool-F7)-эллипс, айлана чизиш имконини беради. 
3. (Polygon Tool)-кўпбурчаклар, жадваллар чизиш имконини 

беради. Бу тугма қўшимча тугмалардан иборат:  

 
 
Бу расмда кўриниб турганингиздек, ҳар бир тугмага тегишли 

бўлган объект саҳифада чизилиб кўрсатилган. Ойнанинг юқори қисмида 
жойлашган 

қато
р ёрдамида белгиланган объект устида ҳар хил ишларни бажариш мумкин. 

8.  (Basic Chapes)- ўзига хос расмларни чизиш имконини 
берувчи буйруқлардан ташкил топган. (14-расм) 



66 
 

 
 

9.  (Text Tool-F8)-Матн ёзиш имконини беради. 

10.  (Interactive Blend Tool)-тайёр объектларни ўзгартириш 
имконини берувчи буйруқлардан ташкил топган.  -бу 
тугмаларнинг ҳаммаси ўзига яраша вазифага эга. 

11.   (Eyedropper Tool)-ранг танлаш ва фон бериш имконини 
берувчи буйруқлардан иборат. ( ) 

А) -объектлардан ранг танлаш имконини беради. 

Б) -фон бериш имконини беради. 
12.  (Outline Tool)-чизиқлар устида ҳар хил ишларни 

бажариш имконини берувчи буйруқлардан иборат. 

  -бу тугмалардан ҳар бири ўзига яраша 
вазифага эга. 

13.  (Fill Tool)-бу тугма белгиланган объектларнинг ичига 
ранг, ҳар хил фонлар бериш имконини берувчи буйруқлардан ташкил 
топган. Бу тугманинг вазифаларини Objeсt Properties ойнаси орқали хам 
бажариш мумкин. 
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. Бу тугмалар ҳар бири ўзига хос вазифага эга. 
Уларнинг вазифалари ва имкониятлари билан юқорида тўлиқ танишиб 
ўтилган. 

14.  (Interactive Fill Tool)-Градиент бўяш. Бу икки типдан 
иборат. 

 - Бу тугмалар градиент бўяш учун ишлатилади. 
 
Эслатма: Чизиқ кўриниши ва ранги, тўртбурчакнинг ички 

рангларини, фонларни, кубнинг кўринишини ва катталикларини  
фойдаланувчи ўз ҳоҳиши бўйича ўзгартириши мумкин. 
 
                Объектларнинг ажратилиши 
  Бизга маълумки CorelDraw график муҳаррири  алоҳида-алоҳида 
объектлардан ташкил топган. Ҳар хил синфларга тегишли бўлган 
объектлардан ташкил топган кўриниш уларнинг синфлари ва атрибутлари 
билан фарқ қилади, бир қанча объектлар гуруҳлар дейилади. 
 Бу гуруҳларни бир қанча усуллар билан  ажратиб олиш мумкин. 
 1. Объектни инструментлар панели ёрдамида ажратиш. 
 ТЕXТ (текст) ёки  форма менюси орқали объектларни танлаш унчалик 
яхши натижа бермайди. Шунинг учун объект танлашда махсус ПУСК 
(танлаш) инструментидан фойдаланган маъқулроқ. 
   Бу усул билан ПУСК (танлаш) инструменти танлаб объектнинг 
ҳоҳлаган нуқтасида сичқончанинг чап тугмасини босиш керак. Танланган 
объект рамка билан ажралиб туради, унинг марказида эса маркер туради.    
   ПУСК (танлаш) командасини бекор қилиш учун объектнинг устида 
сичқончанинг чап тугмасини бир марта босиш керак. Турлантириш 
операцияси вақтида группа бир ягона объект xисобланади. Лекин шу 
группага кирган объектни босган ҳолда фақат шу объект кўрсатилмасдан 
бир бутун гуруҳ кўрсатилади. 
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    Фақат битта объектни олиш учун  шу объектни дастлаб  сичқончанинг 
чап тугмаси орқали  белгилаб олиб, кейин қизиқтирган объектнинг устида  
CТRL тугмачаси босиб, сичқонча тугмачаси босилади. Шу пайтда маркер 
кўриниши квадрат шаклдан юмалоқ кўринишига келади ва ҳoлатлар 
сатрида ичкарига сатри пайдо бўлади. 
         

      
       
Агар ички объектнинг ўзи гуруҳ бўлса, шу процессни яна такрорлаб, 
ҳoҳлаган объектни яна ажратишимиз мумкин. 
Агар бир вақтнинг ўзида бир нечта элементни ажратиб олиш керак бўлса, 
ПУСК(танлаш) инструмент кўрсаткичи устида  SHIFT  тугмачаси 
босилади. 
   Танланган объектни варақнинг ҳoҳлаган жойига ташлаш учун 
объектнинг  марказий нуқтасидаги координатасини аниқловчи иккита 
атрибути қийматлари ўзгартирилади.     

CorelDraw график муҳарририда 4 та  кўчириш усуллари мавжуд. 
Шулардан энг содда кўриниши ПУСК (танлаш) инструмент кўрсаткичи 
ёрдамида  белгилаб олиб сичқонча ёрдамида тортишдир 

Бу усулда объект танланади ва сичқончанинг тугмачаси танланган 
ҳoлда  қўйиш керак бўлган жойга тортиб кейин қўйиб юборилади. Бу 
ҳoлат нусха олиш деб аталади, чунки объект ўз ўрнида қолиб янги жойда 
яна бир нусхаси пайдо бўлади.                  
        Сичқонча ёрдамида кўчириш жараёнида объект бирдан текис 
кўчмаслиги мумкин, балки аста секин кўчиши мумкин Бу ҳoлат сетга 
улаш режимидан келиб чиққан ҳoлда атрибут тугмаларинг панелини улаш 
ҳамда ўчиришга боғлиқ бўлади. 
  Танланган атрибутлар йўқ пайтдаги панел атрибути тасвири: 
      



69 
 

     
  
Агар танланган объектни ёки объектлар гуруҳини варақнинг қатъий 
танланган жойига жойлаштириш керак бўлса, юқорида кўрсатилган усул 
билан ишлаш анча қийин кечади. Бу ҳoлда  танланган объект марказига 
йўналтирилган координаталар атрибутлари қийматини ўзгартириш керак 
бўлади. Бу қийматлар танланган объект ҳамма қийматлари учун панеллар 
атрибутларида қийматларини ўзгартириш орқали амалга оширилади.     
 

 
 
 Объект марказий координаталарини ўзгартириш  
                                         ускунаси 
       
       ТРAНСФOРМAЦИOН ойна ёрдамида ўзгартириш 
 
Объект марказидан бошқа нуқта координаталари учун объектларни 
кўчириш масаласи юкоридаги кўрсатилган усуллар бўйича ечилмайди. 
Танланган объектни тахминий кўчириш масалан 10мм ўнг томонга 
тахминан кўчириш аниқ натижа бермаслиги мумкин. 

Бундай ҳoлларда кўчиришни автоматизациялаштириш учун 
ТРAНСФOРМAЦИOН (Ўзгартириш) ойнаси ёрдам беради. Уни очиш 
учун меню қаторидан ТРAНСФOРМAЦИOН (ўзгартириш) командаси 
танланади. 
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ТРAНСФOРМAЦИOН ойнасининг кўриниши 
 
   Масштаблаш ва шакллантириш      
 
         Айлантириш Масала ўлчами 
                Жойлаштириш                               Шакл ўзгар-ш 
                                                                      

 
 
 

Бу ойнада қуйидаги бошқариш элементлари жойлашган: 
1. H ва V ҳисоблагичлар объектлар кўплиги ёки танланган 

объектларнинг жойлашган нуқталарини кўрсатади. 
2. Байроқлар гуруҳи  нуқталар гуруҳини бошқариш мақсадида 

ишлатилади. Керакли нуқталарни ташлаш учун ишлатилади. 
3. Apply(Қўллаш) тугмачаси- бошқариш ойнаси элементларининг 

берилган параметрларини ўзгартиришда тартибланган кетма-
кетликда ўзгартириш вазифасини бажаради. 

4. Apply To Duplicate (нусхалашни қўллаш) - Бу тугмачани босиш 
аниқ жойлаштиришни амалга оширади, яъни танланган 
объектнинг нусхасини жойлаштиради. 

             
Масштаб қўйиш ва ифодалаш 
 
  Танланган объектнинг янги масштабини қўйишда объектнинг дастлабки 
ўлчамлари фоизлар кўринишида берилади. 
  Берилган объектнинг ўлчамини  билиш учун инструментлар панели 
ёрдамида  атрибутлар панели ва бошқариш элементлари ёрдамида кўриб 
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олиш мумкин. Келиб чиққан ифодалаш ва масштаб кўрсаткичларини 
тасвирловчи илова ойнаси     қуйидаги расмда берилган:  

 
 
Киритилган матн ёки тасвирлар коэффицентлар майдони деб аталувчи  H 
ва V каторлар орқали бажарилади  
  Юқоридаги мисолимизда ажратилган объект ва уларда масштаб қўйиш 
кўрсатилган; 
а) расмда  - 130 фоизлик пропорционал масштабли 
б) расмда  - 150 фоизлик пропорционал масштабли 
в) расмда  -  баландлиги буйича -150 фоиз масштабли 
г) расмда  -  эни буйича  -150 фоиз масштабли 
  
   Ҳисоблагичлар билан ишлаганда керакли масштаблар киритилиб ёки 
блокировка тугмачалари орқали керакли қийматлар кўрсатилиб, Enter 
тугмаси босилади. Масштаблаш коэфицентлари манфий қийматлар билан 
берилганда юқоридаги тасвирдагидек  объектнинг  мавҳум акслари ҳосил 
бўлади. Ҳисоблагичларнинг ўнг томонида жойлашган тугмалар ёрдамида 
манфий қийматларни ҳам киритиш имконияти мавжуд. Бу мавҳум 
объектларни тез тузиш имконини беради. 
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    Объектлар формасининг таҳрирлаш инструментлари 

Графикали тасвирли объектларни тузишда  бадиий форма 
хоссаларини бирданига тасвирлаш осон эмас. Тасвирларнинг 
фрагментларини қўйишда қалам, ўчирғич  каби ускуналардан фойдаланиш 
анча имконият яратади. Бу дастурнинг афзалликларидан бири олдиндан 
тузилган объектнинг формасини ўзгартиришда  уларни янгидан тузишга 
имконият туђилмайди. Ҳар қандай формани ўзгаришини  қадамма-қадам 
силлиқлик билан бажариш мумкин. 
        Объект формаларини ўзгартириш операциялари кўпчилигини  панель 
инструментида келтирилган форма инструменти асосий таҳрирлагич 
ҳисобланади.  
      Ўчиргич инструменти мураккаб образда тузилган объектларнинг 
яроқсиз қисмини ўчириш учун ишлатилади. Free transform воситаси 
(ихтиёрий ўзгариш) юқорида айтилган объектларни 
ТРAНСФOРМAТИOН ойнаси ёрдамисиз cичқонча кўрсаткичи оркали 
ўзгартиришга ёрдам беради. Лекин бу вариант анча мураккаблиги сабабли  
олдинги вариантларда ишлаш афзалрок. 
  Тугунлар устида ишлаш 
    Ажратилган тугун ёки ажратилган тугунлар йиғиндисини объектларни 
аралаштириш усуллари каби алмаштириш мумкин. Кўп ҳoлларда 
танланган тугунларни cичқонча ёрдамида тортиш ёки курсорни бошкариш 
тугмачалари ёрдамида     суперсилжитиш, Микросилжитиш деб аталувчи 
аралаштириш усуллари қўлланилади. 
 
       Тугунларни таҳрирлаш  
  
Куйидаги расмда ажратилган тугунларни контекст меню ёрдамида таҳрир 
килиш командалари келтирилган.  
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Бу менюда танланган тугунларнинг ёки бир нечта тугунларнинг устида 
ишлаш, яъни таҳрир қилишда ишлатиладиган меню командасидан бошқа 
атрибутлар панели тугмачалари тасвирланган: 
   

 
 

    1   2   3    4   5  6    7   8   9  10  11 12 13  14    15        16     17   
 
Юқоридаги элементлар қуйидагича вазифаларни бажаради: 
1. 1 ва 2 -лар тугунларни қўшиш ва олиш; 
2. 2 ва 4 -лар тугунларни бириктириш ва ажратиш; 
3. 5 ва 6 -лар эгри чизиқли ва тўғри чизиқли сегментлар билан 

ишлаш; 
4. 7-синдириш нуқтаси; 
5. 8-тугунларни текислаш; 
6. 9 -симметрияли тугунлар устида ишлаш; 
7. 10-сегментларни бирлаштириш;  
8. 11-йўналишни ўзгартириш; 
9. 12-автоматик бирлаштириш; 
10. 13-Тармоқларни ажратиш; 
11. 14-тугунни айлантириш; 
12. 15-тугунларни чузиш; 
13. 16-ҳамма тугунларни ажратиш; 
14. 17-тугунларни тенглаш; 
         
       Матн шаклларини ўзгартириш 
 
CorelDRAW  график муҳарририда  киритилган матнни ҳам турли 
шаклларда ёзиш мумкин. 
 Бунинг учун олдин матн  инструментлар  панелидаги ТЕXТ ТOOL 
инструменти орқали белгилаб олиниб, матн киритилади ва  Arrange / break 
apart командалари бажарилади.  

 
 CorelDRAW дастурида объектларни кўриш режими 
 
Corel Draw дастурида объектларни кўришнинг 5 хил режими 

мавжуд: 
1. Simple Wireframe (ажратилган каркас)  
2. Wireframe (каркас)  
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3. Draft (эскиз)  
4. Normal (нормал)  
5. Enhanced (янгиланган).  
 
Буларнинг ҳаммаси менюнинг View бўлимида жойлашган бўлади. 
1-кўриш режимида объектларнинг ички ва ташқи ранглари, чизиқ 

қалинликлари умуман кўринмайди (оқ-қора тасвирда бўлади) 
2- кўриш режимида хам 1 -кўриниш режимидагидек бўлади, фақат 

бу ҳoлатда объект чизиқ контурлари сақланиб қолади. 
3- кўриниш режимида ички ранглар, яъни объектга берилган 

фонлар бир фонли фонларга айланадилар. 
4- кўриниш режимида объектнинг тўлиқ чизиқ ва фон ранглари 

акс эттирилади. 
5- кўриниш режимида объектларнинг кўриниши икки баробар 

кучайтирилган режимда кўриниб туради. 
Объект (саҳифани) кўриниш масштабини ўзгартириш учун 

экрандан фойдаланиш мумкин. (Бу ишларни клавиатурада ва сичқонча 
ёрдамида ҳам бажариш мумкин.) 

 
Объектнинг кўриниш масштабини ўзгартириш учун асосан 

фойдаланувчилар Zoom (масштаб) панелидан фойдаланадилар. 
Zoom панелини қуйидагича ҳосил қилиш мумкин:  
Стандартная панелига сичқонча кўрсаткичи олиб борилиб ўнг 

тугмаси босилади, чиққан буйруқлар ичидан Zoom танланади.  
Zoom панели қуйидаги тугмалардан иборат: 

 

Кўриниш  
масштабини 
ўзгартириш 
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-масштаб. 

-масштабни катталаштиради.     - маштабни кичрайтиради. 

 - белгиланган объектни катталаштиради.  - белгиланган 
объектни  кичрайтиради. 

 - саҳифани бутунлайича кўрсатиш.  - саҳифани эни бўйича 
кўрсатиш. 

 - саҳифани бутун бўйича кўрсатиш. 
 
Объектларнинг саҳифада кўринишини ўзгартириш учун View 

Manager (Кўриниш диспетчери) дан ҳам фойдаланилади. Фақат унинг 
имкониятлари бошқачароқ.  

Кўриниш диспетчери Tools-View Manager (Кўриниш диспетчери) 
амалларини бажариб экранда қўшимча ойна сифатида (ўнг бурчакда) 
чиқарилади. Бу кўриниш диспетчери фойдаланувчига объектларнинг 
маълум қисмларининг кўринишини эслаб қолиш имконини беради ва у 
қуйидаги бўлимлардан  ва тугмалардан иборат:  

 

 - масштабни бир марта катталаштириш имконини беради. 

 - масштабни катталаштиради.  - масштабни кичрайтиради. 

 - белгиланган объектни катталаштиради. 

 - белгиланган объектни кичрайтиради. 

 - каттароқ.   - кичкинароқ. 
 Объектлар билан ишлашнинг биз юқорида оддий, оммабоп усулларини 
санаб ўтдик. Corel Draw дастурида бир қанча тушунчалар борки, шу 
ўринда уларни айтиб ўтмасдан бўлмайди. 

1. Линейка - узунлик ўлчов бирлигида ифодаланган, ишчи 
муҳитдаги чизиқлар шаклидаги элементларга айтилади. Уларнинг ўлчов 
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бирликлари узунлик ўлчов бирликлари каби бўлади. Лекин, улар узунлик 
ўлчов бирликларида мавжуд бўлмаган ўлчов бирликларга эга. Масалан: 
Дюйм (Inches)-2,34 см га тенг. Пики ва Пунктлар (Picas; points)-пункт 0,35 
мм га тенг, пики эса 12 бирликка тенг. Пикселли (Pixels)-график расмнинг 
нуқтаси. 

2. Координата сеткалари - маълум қадам берилган горизонтал ва 
вертикал чизиқлар бирлашмаси. Координата сеткалари ишга тушириш 
учун View/Gird амалларини бажариш кифоя. 

 
Сеткалар катталигини бериш учун қуйидагиларни бажариш керак: 

3. Объектларни жойлаштириш, яъни объектларни шундай       
жойлаштирайликки, уларнинг танланган нуқталари битта тўғри 
чизиқда ётиши керак.  

4. Tools-Options амалларини бажариш керак. 
5. Dokument-Grid амалларини бажариш. 
6. Чиққан мулоқотли ойнада Spasing (қадам)ни танлаш (frequuency   
           бўлими чизиқлар сонини бериши имконини беради). 
7. Horizontal ва Vertiсal буйруқларда горизонтал ва вертикал бўйича   
            чизиқлар орасидаги масофани танланади ва Ок босилади. 
Бунинг учун қуйидаги ишлар бажарилади:  

Arrange/Aling and Distribute/Aling ва пайдо бўлган мулоқотли 
ойнада жойлашиши ҳoлати қўрсатилиб, Ок босилади. 

Объектлар устида эса яна мураккаброқ, фақат Corel Draw 
дастурига хос ишларни бажариш мумкин. Бу ишларни бажариш 
жараёнида менюдан, клавиатурадан, сичқончадан, «қуроллар панели»дан 
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унумли фойдаланиш мумкин. Қайси усулдан унга фойдаланиш қулай 
эканлигини фойдаланувчи ўзи танлайди. Биз ҳам фақат айрим, оммабоп 
усулларини санаб ўтдик. 

Corel Draw дастурида объектлар яратиш учун, юқорида айтиб 
ўтканимиздек, ойнанинг ўнг қисмида жойлашган «қуроллар панели» 
фойдаланилади.  Бу қуроллар нафақат объект яратадилар, ёки объектга 
ички ва ташқи ранг беради, балки бу қуролларнинг қўшимча 
имкониятларидан фойдаланиб, биз белгиланган объектлар устида ҳар хил 
амалларни бажариш имконига эга бўламиз. 

 
Сaвoл вa тoпшириқлaр 
 

1. (Pick Tool)-объектни белгилаш. 
2.  (Zoom)-масштабни ўзгартириш. 
3.  (Freehand Tool)-Ихтиёрий чизиқ чизиш. 
4.  (Rectangle Tool-F6)-тўрт бурчак чизиш. 
5.  (Ellipse Tool-F7)-эллипс, айлана чизиш. 
6.  (Basic Chapes)- ўзига хос расмларни чизиш. 
7.  (Text Tool-F8)-Матн ёзиш. 
8.  (Interactive Blend Tool)-тайёр объектларни ўзгартириш. 
9.  (Eyedropper Tool)-ранг танлаш ва фон бериш. 
10.  (Outline Tool)-чизиқлар устида ҳар хил ишларни бажариш. 
11.  (Fill Tool)-бу тугма белгиланган объектларнинг ичига ранг, ҳар хил 

фонлар бериш. 
12.  (Interactive Fill Tool)-Градиент бўяш. 
13. Объект марказий координаталарини ўзгартириш. 
14.  ТРAНСФOРМAТИOН ойнаси. 
15.  Масштаб қўйиш ва ифодалаш. 
16.   Объектларнинг ажратилиши. 
17.   Объектлар формасининг таҳрирлаш инструментлари. 
18.  Тугунлар устида ишлаш. 
19.  Матн шаклларини узгартириш. 
20.  CorelDRAW дасурида объектларни кўриш режими. 
 

 
 

9-Маъруза. Macromedia Flash дастури ҳақида асосий тушунчалар 
 
 
 

Маъруза режаси: 
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1. Macromedia Flash да ишлашнинг асосий усуллари 
2. Қуроллар панели  ускуналари. 
3. Объектларни чизиш ва таҳрирлаш усуллари. 
4.  Вақт шкаласи, анимациялар. 

 
Таянч сўзлар ва иборалар: 
(Pick Tool)-объектни белгилаш, (Zoom)-масштабни ўзгартириш, 
(Freehand Tool)-Ихтиёрий чизиқ чизиш, (Rectangle Tool-F6)-тўрт бурчак 
чизиш, (Ellipse Tool-F7)-эллипс, айлана чизиш, (Basic Chapes)- ўзига хос 
расмларни чизиш, (Text Tool-F8)-Матн ёзиш, (Interactive Blend Tool)-
тайёр объектларни ўзгартириш, (Eyedropper Tool)-ранг танлаш ва фон 
бериш, (Outline Tool)-чизиқлар устида ҳар хил ишларни бажариш, (Fill 
Tool)-объектларнинг ичига ранг,фонлар бериш, (Interactive Fill Tool)-
Градиент бўяш, объект марказий координаталарини ўзгартириш, 
трaнсфoрмaциoн ойнаси, масштаб қўйиш ва ифодалаш,  объектларнинг 
ажратилиши ва формасининг таxрирлаш инструментлари, тугунлар 
устида ишлаш. 
 
1. Macromedia Flash да ишлашнинг асосий усуллари 
Wеb-анимация яратиш воситалари. 

Жаҳонда ярим миллион одамлар Flash теҳнологясидан чиройли 
бўлган Wеb ресурслар яратишда фойдаланади. Дизайнерларни 
Macromedia Flash графика яратишни янги имконятлари ўзига тортади, 
профессионал даражадаги яратувчиалар бўлса, ўзлари ҳоҳлаганча  
скриптларни, шакл ва сервер имкониятларидан фойдаланиб иловалар 
яратиши қодир. 

 
Macromedia Flash фойдаланувчи эсида қоладигандай Wеb-сайтларни 
яратади. Бу восита ёрдамида вектор графикаси ва растли тасвирларни бир-
бирига ўтиш имкониятлари бор овозлар қўшиш, анимациялар яратиш ва 
ҳ.к. эга.  



79 
 

 
  Macromedia Flash Wеb  саҳифаларни яратганда қўл келади ва 
импорт қилиш имкониятига ҳам эга. 
Macromedia Flash катта имкониятларга эга бўлиб Macromedia Generator 
билан ҳам ўз ора боғланган бўлади. 
 
 
2. Macromedia Flash чизиш асбоблари 
 

Расмларни чизиш учун Flash (Drawing Tools) асбобларини 
фойдаланилади. Расмларни ҳоҳлаган векторли муҳаррирлардан 
Macromedia FreeHand,  Adobe Illustrator ва  Adobe Photoshopдан ва ҳ.к. 
дастурлардан растрли тасвирларни импорт қилиш мумкин.  
Flash да расм чизиш осон, фақат асбоблар ёрдамида, ажратиш, боғлаш ва 
бўлакларга бўлиш амалларини бажариш етарли бўлади.  

Асбоблар панелидан ҳоҳлаган асбобни танланг. Танланган асбоб 
турига қарай  асбоблар панели кўриниши ўзгаради. Бу ўзгаришлар 
танланган асбоб билан нима ишлаш кераклигини кўрсатади. Масалан, 
Қаламни танлаганигизда қалинлигини, ранг, чизиқ стили ва сизлар 
автомат тарзда доира ёки учбурчак шакллар билан ишлаш имкониятини 
беради.  
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Тўғри чизиқларни ва штрихларни чизиш  

Тўғри чизиқ ёки штрихни чизиш учун қалам фойдаланиади. 
Чизиқлар битталик элементлар бўлади. Штрих кисточки – соҳани 
контурлар билан тўлдиради.  
 

 
Қалам ёрдамида чизилган чизиқ. 
 
 Flashда чизиқлар чизганингизда эгриларни ўзи автоматик тўғриланади, бу 
ўзингизга ҳавола, эгриларни тўғриланган  кўринишида ёки сиз чизган 
кўринишда қолдирилиши ҳам мумкин. Бу амаллар менюдан танланилиб 
бажарилади. Шу билан бирга чизиқ ранги, қалинлиги, стилини 
танлашингиз мумкин. Қалам ёрдамида тўғри чизиқларни, эгри чизиқларни 
ҳам чизади. Flash асосий геометрик шаклларни автоматик тарзда қабул 
қилади, сиз ўзингизга керакли бўлган эгри чизиқни ҳам танлашингиз 
мумкин. Чизиқларнинг учта хоссаси бор: ранги, қалинлиги, стили.  
Қаламни имкониятларидан фойдаланиб чизиқни ташқи кўринишини 
ўзгартирса ҳам бўлади. Сиз чизиқ рангини  танлашингиз ва рўйхатдан 
ҳоҳлаган рангни танлаш, ёки  иконкали палитрага сичқонча билан 
чертиш орқали ранг танлашимиз мумкин. Булардан ташқари 
қуйидагилардан фойдаланган ҳолда ҳам ранг танлаш мумкин:  
Қалам менючаси   
Бу менюда қуйидагиларни бажарса бўлади:  
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 Straighten (выпрямление)- чизиқларни ва 
эгриларни тўғралаш хоссасига эга. Агарда сиз 
бу опцяни танлаб ва эгри чизиқ чизиб 
сичқончани қўйиб юборсангиз, у зигзаг 
кўринишига айланади 

 Smooth (сглаживание)- чизиқларни тўгрилаш 
хоссасига эга емас фаҳат текислайди. Сиз бу 
опциясини танлаб, зигзаг кўринишидаги 
чизиқни чизсангиз, у тўлқинсимон кўринишга 
келади.   (силлиқланади) 

 Ink (чернила)- cиз чизган чизиқларни ўз 
кўринишда қолдиради. 

 Oval- Овал ва доираларни чизади. Сичқонча 
ёрдамида диагонал бўйича бошланғич 
нуқтадан охирги нуқтагача кўрсатилади. 
Агарда "магнит" босилса сизда доира пайдо 
бўлади, курсор атрофидаги айлана қорароқ 
бўлиб катталашади. 

 Rectangle- квадрат ва тўғри тўртбурчакларни 
чизади. Агарда "магнит" босилган бўлса, 
квадрат пайдо бўлишдан курсор атрофидаги 
айлана қорароқ бўлиб катталашади.  

 Line-бошланғич ва охирги нуқталарда тўғри 
чизиқ чизади.Агарда магнит босилса 
горизонтал ёки вертикал чизиқлар пайдо 
бўлади, агарда сичқонча қўйиб юборилса 
курсор атрофидаги айлана қорароқ бўлиб 
катталашади  
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 Чизиқ қалинлиги  
 
Бу опциядан фойдаланганда  қалам учун яна меню очилади. Чизиқларни 
қалинлиги соч қалинлигидан 10 поинтгача бўлади.  
 

 Ўзингизга керакли бўлган   
 қалинликдаги чизиқни   
 танлаш учун менюнинг  
 Custom танланади, ва   
 очилган ойнадан чизиқ   
 хоссалари танланади(Line    
 Settings). Шу ерга керакли бўлган 
чизиқ қалинлигини киритиш керак.

 
 Эслатма: Чизиқларни бир турлари экранда бошқача  
 принтердан босмадан чиқарганда бошқача булиб  
 кўриниши мумкин.  

 
 

Кисточка заливка соҳали тўғри чизиқларни чизади. Кисточка учун 
"Буёқ"  оддий ранг, градиент ёки тайёр файлдан (bitmaps) бўлиши мумкин.  
Бўяш уxун кистнинг  қўшимча опцияларни:  
Fill Color ёрдамида ранг танлаш учун Cоlоr ойнаси очилади. Агарда 
ўзингизни рангни яратмоқчи бўлсангиз  палитрадан фойдаланинг.  
Brush Size кист ўлчамини ўзгартиради. Ҳар хил кист турларини олиш 
учун ўлчамлари ва шаклларини ўзгартириб кўриш керак.  
Brush Shape (нижнее выпадающее окошко) Кист шаклини ўзгартиради.  
Pressure Modifer Агарда сизда дигитайзер бўлса, бу опция ёрдамида 
босимни ўзгартирич имкониятига эга. Испольование карандаша и 
дигитайзера ни қаранг.  
 
Кист ёрдамида чизиш  
Бу менюча кист штрихлари чизишда қандай қўлланишини кўради. Асосан  
Paint Normal  фойдаланилади, бошқа опциялари эса бошқача эффектлар 
яратади.  
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Paint Normal заливкалар ва чизиқлар устидан чизади 
Paint Fills заливка устидан чизади фақат чизиқлар қолдирилади  
Paint Behind (рисование между) расм ён томонида чизилади. 
Paint Selection расмнинг белгиланган соҳаси устидан чизади. 
Paint Inside заливкани сиз тегинган жойларини чизади, чизиқлар ёнини 
қолдириб кетади.  
Заливок қулфи  
 

 Бу асбоб ёрдамида ўлчамини, заливка бурчагини, ёки градиентни 
“қулфлайди”. Кейинга давом эттириладиганградиент ёки заливкалар 
аввалгини давоми бўлиб ҳисобланади.  
 

Чизиқни шаклини ўзгартириш 
Flash ҳеч қанақа чизиқ шаклни ўзгартирадиган ричагларга эга эмас. Шу 
билан бирга, "стрелка" асбобидан фойдаланиш орқали чизиқни 
бўлакларини ўзгартирса бўлади. Стрелка кўриниши сиз чизиққа қандай 
ўзгартириш киритмоқчи бўлганингизга қараб, заливка ёки кисточка 
маскаси ўзгаради.  
Чизиқни кесмасини шаклини ўзгартириш учун: 
Flash чизиқларни узунлигини катталаштириш ва кичиклаштириш мумкин. 
Бу учун охирги нуқтасидан ушлаб керакли томонга суриш керак. Агарда 
охирги нуқта бурчак нуқта бўлса  у ҳолда, у ўткир бурчак бўлади, қайси 
томонга тортишингизга боғлиқ.  
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Кисточка штрихи шаклини ўзгартириш  
 

Заливка шаклини ўзгартиргандай штрих шаклини ҳам ўзгартириш 
мумкин.  
Яқинлашиш штрих шаклини ўзгартиришни осонлаштиради. Кўпгина 
штрихлар уларни контурлари кўринган бўлса тез ўзгартирилади. Буниг 
учун  View > Оutlines  танлайсиз.  
Штрих шакли чизиқни шаклини, заливкани шаклини ўзгартирганга 
ўхшайди.  
Кисточка штрихи кўринишини ўзгартириш:  
1  Йўналишни танланг ва ўзгартирилиши керак бўлган элементга 

сичқончани яқинлаштиринг. 

 Агарда бурчак керак бўлса Ctrl билан сичқончани босинг ва қийматини 
киритинг 

2  Контурни ўчириш учун ластикни танланг.  
 
 
 

Кисточка штрихи оддий ва контур режимларида. 

 

Чизиқларни тўђрилаш ва силлиқлaш 
  
Чизиқларни иш пайтида ёки кейинроқ эгриларни текислашигиз, 
силлиқлашингиз мумкин. 
Эслатма: Автоматик турда силлиқлаш ва текислашни бошқаришда File > 
Assistantдан фойдаланса бўлади.  
Чизиқни, эгриларни текислаш учун Текислаш белгисини танланг  ёки   
Modify > Service > Strengthen бажаринг. Аввал текисланганларга бу амал 
таъсир қилмайди.  
Flash ҳоҳлаган геометрик объектларни доира, овал, тўғритўртбурчак, 
квадрат, учбурчак, ва ярим доира шаклларни чизади. Шу билан бирга бу 
объектларни эгриларини текислаб геометрик кўринишига ҳам олиб 
келади.  
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  Эгриларни текислаш бир неча йўналишларда олиб борилади. Текислаш 
эгридаги кесмаларга ҳам боғлиқ бўлади. Текисланишни бир неча марта 
такрорлаш чизиқларни аввалгисидан эгриларини текисроқ қилади, бу эгри 
чизиқнинг кесмалари қанча даражада эгри ёки тўғрилигига боғлиқ бўлади.  
Белгиланган заливкани ёки эгри чизиқни силлиқ қилиш учун:  
Йўналишни танлаб Сглаживания (силлиқлаш) иконкасига сичқонча билан 
чертилади ёки Modify > Service > Smooth ёрдамида амалга оширилади: 

 
Белгиланган заливкани ёки эгри чизиқни силлиқ қилиш учун 
текислаш:  
Йўналишни танлаб Выпрямления (текислаш) иконкасига сичқонча билан 
чертилади ёки Modify > Service > Strengthen ёрдамида амалга 
оширилади:  
Эгриларни оптимизация қилиш 
Эгриларни силлиқлашнинг  яна бир тури уларни оптимизация қилиш 
бўлади. Бу опция эгридаги чизиқлар сонига боғлиқ бўлган турда 
чизиқларни ва заливкаларни силлиқлайди. Бу буйруқни бир неча марта 
ишлатса ҳам бўлади.  
Эгриларни оптимизация қилиш:  
1  Расмни элементини танлаб Modify > Service > Optimize босинг.  
2  Мулоқот ойнасидаги Optimize Service да силлиқланиш даражаси 

кўрсатилади 

 Натижа танланган эгриларга боглиқ бўлади. Оптимизация эгриларни 
сонини камайтиради. 

3  Қўшимча опцияларни ишга туширинг: 

 Use Multiple Passes ишга туширилганда эгри чизиқ силлиқ бўлганича 
процесс қайталанади. Бу силлиқланишни қайта қайта босган Билан 
бора бор. 
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 Show Totals Message  қўшиш оптимизация қилиш мумкин эмаслиги 
ҳақида сигнал бериб  ойнаси чиқарилади. 

  
Ассистентдан фойдаланиш 
Feli > Аssistant буйруғи ассистент ойнасини очади. Бу ойнадаги 
чизиқларни айланиш қийматини, чизиқларни, эгриларни таниш ва 
магнитлаш учун опциялар берилади.  
Ҳар бир опцияни ўчирилиш ва ишга қўшиш мумкин. Опцияни ўзингизга 
маъқул бўлганинча қилиб созлашингиз мумкин. Эркин фойдаланиш 
даражасини ишга туширинг. Эркин фойдаланиш даражаси мониторга 
боғлиқ бўлади (100% 200% 300%  в ҳ.к.). Расм чизганда иш столини 
яқинлашиши иш самарадорлигини оширади.  
Snap to grid ("прибить" к разметке) 
Чизиққа бириктириладиган белгилар орасидаги масофани билдиради. 
Ўчириш опцияси, яқин бўлиш,  нормал, берилган масофада бўлиш ва 
ҳамма вақтда бириктириш ўз ичига олади.  
Connect lines (состыковка линий)  
Чизиқни оxирига қанча борлиги оптяси. Опциянинг турлари: ўчириш, 
яқин бўлиш, нормал, масофада бўлиши керак. Бу опцйлар вертикал ва 
горизонтал чизиқларни танишни билдиради: Flash чизиқни идеал вертикал 
ва горизонталга яқинлигини билдиради.  
Smooth service (сглаживание кривых) 
Қалам билан чизилган чизиқни текисланиш даражасини билдиради (қалам 
опцияси Strangthen or Smooth бўлиши керак) Опциялари: Может быть 
выключено, закругленно, нормально и сглажено (Оff, Rough, Normal and 
Smooth)  
Recognize lines (распознование линий) 
Танишдан олдин қандай даражада текис бўлишини ва идеал тўғри қилиб 
чизишни аниқлаш. Вариантлари: выключено, точно, нормально и 
приблизительно ( Off, Struct, Normal, Tolerant.)  
Агар у иш пайтида ўчирилган бўлса, танишни Modify > Cervice > 
Strangthen ёрдамида амалга оширасиз.  
Recognize shapes (Распознование кривых) 
Оваллн, доирани, квадратни, тўғритурбурчакни, бурчакларни 90 ёки 180 
градусли, қандай даражада тўғри чизилганлигини назорат қилади. 
Опциялари: Отключено, точно, нормально и приблизительно (Off, Struct, 
Normal, Tolerant).  
Агарда эгриларни таниш иш пайтида ўчирилган бўлса, Modify > Cervice > 
Strangthen ёрдамида бир ёки бир нечта эгриларни танлаб амалга оширасиз.  
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Click accurate (точный щелчок)  
Flash объектни танишдан аввал объектга кўрсатгиш қанчали яқин 
келишини билдиради.Опциялари: точно, нормально и прблизительно 
(Struct, Normal, Tolerant.)  
 
График элементларни ажратиш 

Flash объектларни ажратиш учун бир-қанча асбобларга эга.  
"Стрелка" асбоби  -ажратишнинг универсал асбоби ҳисобланади. 
"Рисование" панелидан асбоб танланади ёки  А белгиси босилади. Бўш 
жой тугмаси ёрдамида ҳоҳлаган асбобни “ стрелка ”га  ўтказишимиз 
мумкин.  
Унинг элементларини  ажратиш учун  "стрелка" асбобини чертинг. Бошқа 
дастурлардан фарқи иккинчи объектни ажратилган ларга бир марта 
сичқонча билан чертиш билан қўшасиз. Бу амални Shift тугмасини босиб 
туриб чертиш билан бажариладиган қилиб созлаш ҳам мумкин:(edit-> 
preferences )  
Қуйида ажратишни бошқа турлари берилган.  
 

 Бир бирига яқин бўлган расмни элементларини ажратиш учун 
"стрелка" асбоб ёрдамида екки марта сичқонча билан чертиш керак.  

 Квадрат соҳадаги элементларни ажратиш учун, сичқонча ёрдамида 
квадратни чизиш керак. Белгилар,матнлар ҳаммаси ажратилган 
бўлиши учун чизилган квадрат ишида жойлашган бўлиши керак. 

 Ҳоҳлаган шаклдаги саҳадаги нарсаларни ажратиш учун "лассо" 
ёрдамида соҳа белриланиши керак. Соҳа "лассо" ёрдамида чизиб 
булингандан кейин “лассо” ёналишга айланади ва ажратилган соҳани 
силжитиш мумкин. 

 Бир вақтни ишида бир нечта соҳаларни ажратиш учун Shift тугмасини 
босинг  

 Ҳамма қатламларни ажратиш учун  Edit > Select all ни танланг, ёки 
Cоntrol-5 босилади. 

 Ажратишни бекор этиш учун  Edit > Deselect all ёки  Cоntrol-  Shift-5 
тугмаларини босилади. 

 Ажратилган гуруҳ объектларини ёки белгиларини ўзгармас ҳолга 
келтириш учун, Моdify> Аrrange > Lock танланг. Қулфни очиш учун 
Моdify> Аrrange > UnLockAll танланaди.  
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Ажратилган соҳа матнли  кўринишда  чизиқлари эса "қалинроқ" ва матн 
кўринишда, гуруҳ объектлари, белгилари, матнлари квадрат билан ўралган 
бўлади. 
 
Ажратилган элементлар бошқа элементларни учирмайди ва бўлмайди. 
Агарда бита қатламда жойлашган расм элементларидан объектни  
ажратишни бекор этсангиз у ҳолда, объект устидаги элемент билан 
ёпилган соҳа силжитилади ва пастки элементни бўлади.  

 
 
График элементларни силжитилиши 

Ҳамма элементларни бир вақтда силжитиш учун "стрелка" 
асбобидан фойдаланмиз. Аввал бир марта сичқонча ёрдамида чертилиб 
объектларни чизиғини ажратамиз. Агарда чизиғи ажратилмаган бўлса у 
ҳолда силжитилиш ўрнига объектни шакли ўзгаради ва уни 
силжиталмайсиз. Агарда бир-нечта объектлар ажратилган бўлса у ҳолда 
керак бўлмаган объектларда ажратишни бекор қилиб кераклисини 
қолдириб амални бажаришингиз мумкин.  

Клавиатурани йўналиш тугмаларини фойдаланиб объектларни 1 
пиксел масофага силжитиш мумкин. Агарда бу амалларни Shift тугмаси 
билан биргаликда ишлатcангиз 8 пикселга силжитилади.  
Объектни белгили жойга силжитиш учун инспектордан фойдаланинг. 
Инспектор ойнасидан силжитилиши керак жойни қиймати киритилади. 
(Windows->Inspector)  

Агарда ажратилган заливкани иккинчи заливка устида 
силжицангиз, ва кейин ажратишни бекор қилсангиз, расмни устида 
жойлашган қисми кесилиб тушади. Бу оддий расм чизиш дастурларига 
ўхшаш бўлади. 
 

.  
 

Заливка устидан чизиқ чизишни тушиниш учун чизиқ чизамиз ва 
бизнинг кутганимиздай чизиқ заливкани иккига бўлиб заливка билан 
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қўшилмайди. Flashда, чизиқлар заливка билан қўшилгандан кейин белгили 
битта нуқтада бўлинади, натижада чизиқ учта қисмга бўлинади, буларни 
келтирилган расмда кўришимиз мумкин. Чизиқ бўлимларидан биттасини 
бошқасига боғлиқ бўлмаган ҳолда шаклини ўзгартириш, силжитиш 
амалларини бажариш мумкин.  
 

 
 
1.Заливка  
2.Заливка устига чизилган чизиқ  
3.Иккита эгри ва учта кесма чизиқ билан заливкани қўшиш натижасида 
пайдо бўлган.  

Бириктириш ва бўлиш дастурлардаги кесиш ва қўйиш  амалларида 
фарқи йўқ. Бир хил эгри чизиқлар бириктирилганда қўшилиб кетади. Ҳар 
хил рангдагилари эса алоҳида бўлади. Бу имкониятларини ниқоб 
яратганда фойдаланса бўлади, кесиш натижасида бошқа объектларни 
олиш учун ишлатилади. Масалан, қизил квадратдаги баргни кесиш 
натижасида олдик: Аввал қизил рангли квадрат яратилди, кейин 
гуруҳланмаганини барг расмини олиб қизил квадратга қоямиз. Кейин 
баргдан ажратишни бекор қиламиз ва қора рангли баргни сурамиз. Қизил 
квадратда эса кесилган барг ўрни қолади.  
 

 
 

Эгри чизиқларни гуруҳга қўшиш натижасида бириктириш ва 
бўлиш (Соnnection and segmentation) амаллари бажарилмайди. 

  
Заливка артибутларини ва чизиқларни нусхасини олиш 
Чизиқларни ва заливка атрибутларини яъни қалинлиги, 
ранги,градиентиларидан нусха олиш учун   сиёҳдон, пипетка ва заливкали 
челакдан фойдаланилади. Тайёр элементдан атрибутларини нусхасини 
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олинг ва пипетка ёрдамида ва заливкали челак ва сиёҳдонлардан 
фойдаланиб элемент устига ташланг.  
Сиёҳдон 

Сиёҳдон чизиқни рангни, қалинлигини ва стилини ўзгартиради. 
Чизиқ чизинг ва сиёҳдондан бошқа ранг, стил кабилар танланади. 
Охирида чизилган чизиқга чертиш керак ва у чизиқ ўзини атрибутларини 
ўзгартиради. Агарда бир-нечта чизиқларни белгилаб cиёқдонга сичқонча 
билан чертилса у ҳолда барча чизиқлар атрибутларини ўзгартиради  
 
Заливкали челак  (заливка) асбоби 

Заливка асбоби ёпиқ соҳаларни ранглар ёки градиентлар билан 
тўлдиради. Аввал тўлирилиши керак жойни кўрсатиб чертиш керак. 
Агарда бир-нечта заливкаларни танлаб, кейин бу асбоб босилса 
(рангларини ўзгартириб) ҳамма элементлар рангини ўзгартиради. 
  
Fill Color (заливка ранги)  (Color)  менюсини чақиради. Ранг танланади. 
Агарда ўзингиз ранг яратмоқчи бўлсангиз (Color Palette) палитрасини 
сичқонча билан чертасиз.  
Gap Size (масофа оралиқи) Тўлдирилиши керак бўлган соҳа чизиқлар 
орасидаги масофани кўрсатадиган меню чиқарилади. Агарда автоматик 
тарзда тўлдириш танланса Close танланади. Агарда бошқа ранг билан 
тўлдимоқчи бўлсангиз Don’t Close Gaps ни танланг.  
 

 LockFill (заливка қулфи) Жорий заливкани ўлчами, бурчаги ва 
марказини қулфлаб қояди. Агарда заливкага пипетка олиб келинса 
қулф чиқарилади. Янги ранг, градиент бермоқчи бўлсангиз қулфни 
очичга тўгри келади. 

 ТransformFill (заливкани ўзгартириш) заливкани ўлчамини, бурчаги 
ва марказини бошқаради. Бу опция танланганда заливкали челак 
ёналишга ойланади. Дойда чизинг ва градиент билан толтиринг. Бу 
опцияни танлаб градиент ёналишини ва ойини ўзгартиринг.Агарда 
градиент чегарсини кўринмаса  у ҳолда View > Wоrk Аrеа танланг. 

"Пипетка" асбоби 
Пипетка тайёр тасвирни ранги ва стили ҳақида маълумот олади. У фақат 
ранг ва стилни нусхалайди. Агарда заливка соҳасига сичқонча билан 
чертсангиз пипетка атрофида мўйқалам белгиси чиқади, агарда чизиқни 
танлаган бўлсангиз қалам чиқади. Қалам ва заливкали челак асбоблари 
пипетка сичқонча билан чертганда пипетка нусхалаган рангни ва стилни 
беради.  



91 
 

Агарда Shift билан бирга пипеткани сичқонча билан чертилса у 
пипетка нусхалаган ранг бир вақтнинг ўзида  қаламда, заливка челагида ва 
матн асбобларида пайдо бўлади. 
 
Ластик менюси 
  
Меню опциясида ластик қандай қилиб ўчиришини кўрсатади. Ластик 
опцияси мўйқалам асбобига ўхшаш бўлади.  
 

 Нормал опция – чизиқларни ва заливкаларни ўчиради. 

 Еrаsе Fills фаҳат заливкани учиради.Агарда чизиқга тегиниб кеца у 
учмайди. 

 Еrаsе Lines фақат чизиқлар ўчирилади. Заливкаларга тегинса ҳеч 
қандай ўзгаришсиз қолади. 

 Еrаsе Selected Fills ажратилган заливкаларни учиради ва чизиқларни 
ажратилган ва ажратилмаганидан қатий назар улар учмайди. 

 Еrаsе Inside бошлаб ўчирган заливка соҳаси ўчирилади.           (агарда 
бўш жой ўчирилган бўлса ҳеч нарса ўчмайди) Чизиқлар ўчирилмайди. 

Сув крани  
 

 Чизиқ бўлагини ёки соҳаларни ўчиради. Аввал ластикка ва кейин 
кранга чертинг. Агарда  сиз чизиққа ёки заливкага чертсангиз ҳаммаси 
йўқолиб кетади. 
 
 

3. Объектлар билан ишлаш 
 

 Айлантириш ва акслантиришлар 
Бир вақт ичида битта ёки бир-нечта элементларни айлантириш ёки 
ўлчамларини ўзгартириш имконияти мавжуд.  
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Тескарилаш(Flip)  
 
Ажратилган элементни тескари қилиш учун:  
Modify > Transform > Flip Vertical ёки FlipGorizontal танланади.  
 
Айланиш 
Ажратилган элементни айлантиришни бир нечта усуллари мавжуд. Агарда 
эркин айланишни танласангиз (асбоблар панелидаги рисования тугмаси) 
ўлчамини, қиялигини томонларидагиад берилган айланаларни суриш 
орқали амалга оширасиз.  
Соат стрелкасига қарши 900 градусга буриш.  
Modify > Transform >RotateCWR Left танланг.  
Соат стрелкаси бойивҳа  900 градусга буриш.  
Modify > Transform  > RotateCWR Right танланг.  
Берилган градус остида буриш  
Modify > Transform > Scale and Rotate ни танланг ва -360° дан 360°  гача 
сон қийматини беринг.  
Ажратилган элементни эркин айлантириш:  
Қуйидаги берилганлар бажарилади:  

 Modify > Transform  > Rotate ни танланг ва шаклингизни кўрсатилган 
бурчак бўйича айлантиринг 

 "стрелка" асбобини танланг ва пастга айланган икончага чертинг 
 ва шаклгани кўрсатилган бурчакка буринг.  

 
Ажратилган элементни қия  (skew)қилиш:  
Қуйидаги вариантларнинг бири танланади:  

 Танланг: Modify > Transform  > Rotate ва ҳоҳлаган томонлари 
ўртасидан тортинг. 

 Йўналишни танланг ва  буриш (Rotate) тугмасини босинг ҳоҳлаган 
томонлари марказидан тортинг.  
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Танланган элементни чўзиш:  
 Танланг Modify > Transform  > Rotate > Scale ва марказдан ҳоҳлаган 

йўналишда тортинг. 

 "стрелка" асбобини танланг ва  катталаштириш (кичиклаштириш) 
белгисини босинг. Марказдан ҳоҳлаган бурчак остига тортинг. 

Берилган элементни ўлчамини ўзгартирш пайтида тескари қилиш:  
Ўртача белгидан пастга марказ томон тортинг (расмда берилган). (чапга, 
ўнгга юқорига марказ томон) 
 

 
 
Объектларни текислаш 
Modify > Align иккита ёки бир-нечта ажратилган объектларни текислайди. 
Текислаш элементлар энини ва бўйини бир хил бўлиши учун ўлчамларини 
ўзгартириши мумкин. Ўлчами энг катта элементга қараб танланади. Шу 
билан бирга объектларни унг томонга, марказдан, чап томонга, юқори 
томонга бир хил масофада қилиб текислайди. Align  to Page опцияси бир-
бирига ва cаҳнага нисбатан тўғрилайди.  

Бир нечта объектлар текисланганда, Flash уларни ён томонлари, 
маркази нима яқин бўлса, ўшанга нисбатан текислайди. Объектларни 
қандай тартибда киритиш аҳамияти йўқ.  
 

    
   Берилган объектлар                                        Юқори нуқтага нисбатан   
                                                                              текисланган объектлар 
 
Энг яхши вариантларидан бири объектларни аввал нусхасини олиш кейин 
гуруҳга олинг. Бу эса текислагандан кейин муҳаррирлаш ва алоҳида 
қолишга ёрдам беради. Агарда ажратилган объектлардан  бир-бири билан 
бириктирилса ёки бир-бирига яқин бўлса натижа кутганимиздай 
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бўлмайди. Бир-бири устида жойлашган элементлар текислашдан ва 
ўлчамларини ўзгартгандан  кейин бўлакларга бўлинади. 
 
Кесиб олиш, йўқотиш, нусхасини олиш ва объектларни қўйиш 
 

Flashда объектларни кесиш (Cut) йўқотиш (delete), нусxасини 
олиш (copy) ва қўйиш (paste) амалларини бажарилиш бошқа дастурларга 
ўхшаш бўлади.  

Объектларни кесилгани ва нусхалари берилган роликни (movie) 
ёки бошқа роликни  сценаларга ёки қатлaмларга (layers) қойилиши 
мумкин. Объектларни қўйишни иккита тури мавжуд: биттаси кўрсатилган 
жойга (Paste in Plase), иккинчиси  (Paste), ишcи майдонига қойилади. 
Бошқа роликдан (movie) олинган графика ёки  дастурлар жорий фреймга 
(frame) жорий қатлaмига  (layers) қўйилади. Flashга график элемент қндай 
бўлиб қойилиши унинг типига, опциясига боғлиқ бўлади 
  
  Ранглар билан ишлаш 
 
Рангларни яратиш ва муҳаррирлаш 

Рангни, тиниқлилик даражасини  ўзгартириш  учун (Colors) 
ойнасидан фойдаланамиз. Жорий асбоб учун ранг ва градиент ойнани 
пастки қисмида кўрсатилган. Агарда Flashни биринчи марта ишлатятган 
бўлсангиз, (Colors) менючасидаги ранглар жадвали берилган роликда 
ишлатиш имкониятига эга.  
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Flash ролик Colors да берилган ранглардан кўп бўлиши мумкин. Роликдаги 
ранглар компьютер видеокартасига боғлиқ бўлади.  
 
Рангни  яратиш ёки ўзгартириш  
 

 
1.  Палитрага сичқонча билан чертилади ёки менюдан Window > Color 

буйруғи бажарилади.  
 

 
 

2.  Цельный (Solid)га чертилганда тоқ рангдаги ранглар палитрадан 
чиқарилади. 

3.  Сиз ўзгартирмоқчи бўлган рангни танланг 
4.  Рангни қуйидаги усул билан ўзгартиринг: 

 Рангга очиқ ёки тўқ бўлишини таъминлаш учун, ранг ойнасидан 
крестик белгисини олиб ташланг. 

 Тиниқлигини созлаш учун тиниқлик ричагидан фойдаланинг ва 
тиниқлиқ бўлмаган қийматини фоиз ҳисобида киритинг(100 бўлса – 
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бутунлай тиниқ эмас ранг). Ярим тиниқ бўлган қизил ранг қуйидагича 
кўринишда бўлади: 

 
 Қизил ранг қийматини- Р, ёшил ранг қийматини- Г, ва  кўк ранг 

қийматини- Б керакли рангни олиш учун ўзгартириш мумкин.  
5.  Рангларни ўзгартиришни тугатгандан кейин қуйидагиларни бажаринг: 

 Танланган рангни янгисига ўзгартириш учун Change тугмасини 
босинг. 

 Палитрага янги ранг қўшиш учун Nеw тугмасини босинг. (ранг ойнани 
пастки қисмида чиқарилади) 

 Танланган рангни ўчириш учун Delete тугмасини босинг. 

 Роликни браузерда чиқариш учун  рангларни 216 га яқин қилиб 
танланг. 

 
Градиентларни яратиш ва муҳаррирлаш 

Градиентни яратиш ва муҳаррирлаш учун (Color) ранг ойнасидан 
фойдаланиг. (Color) ойнасидаги  Градиент жорий вақтдаги ишлаш 
мумкин бўлган грaдиентларни кўрсатади.  
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Градиент бу иккита ёки ундан кўп бўлган (16 гача) рангларнинг  бир-
бирига ўтиши. Градиент (linear) чизиқли ёки (redial) айлана шаклида 
бўлади. Градиентдаги ранг баpибир даражада тиниқ бўлади.  
Градиентни яратиш ёки муҳаррирлаш:  
1.  Палитрадаги тугмага сичқонча билан чертинг ёки менюдан Wиндоw > 

Cолорс бажаринг. 
2.  Градиентни сичқонча ёрдамида чертинг. 
3.  Янги градиент учун асосини танланг. 
4.  "Тип градиента" ойнасидан Radial ёки Linear дан биттасини танланг. 
5.  Ранг кўрсатгичини белгиланг уни ўзингиз ҳоҳлагандай қилиб 

ўзгартиринг ва уни ранг ўзгарадиган жойга силжитинг. 

 

Ранг кўрсаткичи ранг градиентга ўтадиган жойини кўрсатади. Яна 
битта кўрсаткич қўшиш учун   "рычажок добавления градиента" 
фойдаланинг. Агарда кўрсатгични ўчирмоқчи бўлсангиз, ва уни 
силжитиб  "рычажкам добавления градиента (в крайний левый угол) " 
га жойлаштиринг. 
 

 
 

6.  Ҳар бир ранг тиниқлигини, рангларни ўзингиз ҳоҳлагандай қилиб 
танланг. Буни  Создание и редактирование цвета. мурoжаатидан кўрса 
бўлади.  

 Градиентдаги ҳар бир ранг ўзининг тиниқлигига эга. 
7.  Рангни қўшимча кўрсатгичлари учун ранг ва тиниқлиқни танланг. 
8.  Жорий градиентни ўзгартириш учун  Change тугмасини босинг. Янги 

градиентни қўшиш учун Nеw ни босинг. Янги қўшилган градиент 
рўйxатда энг охирига қўшилади. 

 Танланган градиентни ўчириш учун Delete тугмасини босинг. 
 
 
 
 
 
 Ҳаракат (Анимациялар) 



98 
 

 
M otion tweening  

Бу восита Flash нинг асосий асбобларидан биттаси бўлиб, oддий ва 
саморадорли воситаларидан ҳисобланади:  

 
 

Кадр (Frames - Кадр) - Flash ва купкина анимацион мухаррирлар 
хамда видео монтаж дастурлар асосида кадрлар кетма кетлиги 
жойлашган. Кадрни сиз узингиз чизиб яратишингиз ёки дастур 
уни узи автоматик яратиши мумкин. Кадрлар ичида бошкарув 
кадр (keyframes - ключевой кадр) тушунчаси мавжуд булиб, у 
харакат траекториясининг нукталарини белгилайди. Автоматик 
яратилган кадрлар эса икки хил булади: шакллар геометриясини 
узгариши (shape tweening) ёки бошкарув кадрлар узгариши (motion 
tweening) асосида яратилган кадрлар .  
Кадрлар устидан бажариладиган асосий амаллар 
F7 ёки Вставка менюсида Вставить пустой ключевой кадр (Insert 
blank keyfrme) - актив катламда янги буш бошкарув кадр яратиш. 
F6 ёки Вставка менюсида Ключевой кадр (Insert keyframe) - актив 
катламда кейинги бошкарув кадрини яратиш 
Shift+F6 ёки Вставка менюсида Очистить ключевой кадр (Clear 
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keyframe) - актив катламда танланган бошкарув кадрини тозалаш 
F5 ёки Вставка менюсида Кадр (Insert frame) - актив катламда буш 
кадрини яратиш 
Shift+F5 ёки Вставка менюсида Удалить кадр (Remove frames) - 
актив катламда танланган кадрини тозалаш 

 
 
Фойдаланувчи фақат биринчи кадрни ва охирги кадрни(frame) 

яратади, Flash эса булардан анимация яратади. 
 

1 - қадам. Белгини яратинг (F8 ёки Insert -> Create symbol). Уни ҳаракат 
"motion"(движение) деб номлаймиз. 
2 -қадам. Юқорига йўналишини босиб сценага ўтинг (юқоридаги ўнг 
томондаги "прокрутка" осмон кўк рангли йўналиш, буни босиш орқали 
белгиларни яратиш ойнасидан сценага ўтамиз.) F6 тугмаси ёрдамида 
кадрни бошланғич калитини (keyframe) яратинг. 
3 - қадам. Кутубхонани (windоw ->library) очинг. Белгини кутубхонадан 
керакли фреймга (кадр) ўтказинг (бу учун Actor(белги) пайдо бўлганича 
вертикал йўлакча – кўрсаткич фреймда туриши керак, шу   пайтгача у кўк 
рангда бўлган доира шаклида эди). 
 4 - қадам.  Йўлакчани ҳоҳлаган фреймга ўтказинг (Бу сизни анимация 
қанча вақтга мўлжалланганлигига боғлиқ  10-15-20 ва ҳ.к. фреймлардан) 
Анимация тугаган жойда F6 тугмаси босилади    (сиз актёрингизни саҳна 
бошланишида қайси жойида қайси туришини кўрсатишингиз керак). 
Иккита кўк рангли доирага эга бўлдик ва актер бошланғич ва охирги 
туришларини ҳосил қилдик. 
5 - қадам. Фреймни охирги кадрига йўлакча сургични олиб келинг. 
Билгини жойини ўзгартиринг пастга, юқорига ҳоҳлаган томонга 
ўзгартиринг. Уни айлантиришингиз (rotate), катталаштиришингиз (Scale) 
ҳатто қия қилишингиз мумкин    (Scale ва rotate). Кўрсатгич охирги кардда 
турганига эътибор беринг.  
6 - қадам. Кўрсаткични (режиссёрни) фрейм биринчи кадрига олиб 
келинг. Доирачага икки марта чертинг (ёки сичқончани ўнг тугмаси 
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босилиб  properties танланилади). Биринчи кадр ойнаси чиқарилади. 
"Тwееning" ни танланг ва менюдан "Моtion Тwееn" танланади. Агарда 
актёрни айлантирмоқчи бўлсак "rotаte"ни танланг. Ҳар қил қийматлар 
билан ишлаб кўринг. 
Тwееn Scaling –да актёр анимация вақтида катталашади ёки кичиклашади. 
Rotate Clockwice- соат стрелкаси бўйича айланади (неча марта 
айланишини ойнадан кўрсатинг).  
Rotate SounterClockwice– соат стрелкаси йўналишига қарши айланади.  
Orient to patch direct – биз кўрсатган йўналиш бўйича ҳаракат (анимация) 
бўлади. Буни кейинги мисолларда кўриб ўтамиз. 
Easing In – анимация бошида секин, охирида тез айланадиган бўлади. 
Easing Out – аввал тез, кейин секин айланади. 
 
Энди тайёр анимацияни кўриш учун  ОК тугмасини, сўнгра Play босинг. 
 
Shape Twееning (morfing) 
 
Shape Twееning жуда кучли элементлардан. Бу асбобдан фойдаланишни 
ўрганамиз. 
 
1 - қадам. Янги “спектакл”("спектакль"(моvie)) File -> new ёки Ctrl+N 
ёрдамида яратилади. 
2 - қадам. Тўғридан тўғри сценага объектларни қўйинг (бу амални 
MovieClip ёки Graphics яратиб бўлиб белгиларни кутубxонадан movie 
кўчириб қўйишни унутманг). Morfing учун қуйидагилар бўлади: 
Flash асбобларидан ихтиёрийси олинг.  
bmp, gif, jpeg  кенгайтмали файлларни  импорт қилинг. (агарда шундай 
қилмоқчи бўлсангиз, Break apart (modify -> break apart) ёки  ctrl +B ни 
босиш керак) ёки  trace bitmap (modify -> trace bitmap) бажаринг. 
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Flashни импорт қилинган белгилари.  
Албатта Flashдаги матн  ёки шрифтни фойдаланинг.  
3 - қадам. Охирги кадрни яратинг, у бош бўлиши керак. (курсорни, 
масалан,  10(20, 30, 100) кадрларга суринг, сичқончани ўнг томони 
босилади ва   "Insert blanc key frame" (бўш кадр қўйиш) босилади. Ёки  
ҳоҳлаган фреймга сичқонча билан чертилади  ва F7 тугмаси босилади. 
Кейин (курсор охирги фреймда туради) бошқа расмни яратинг ёки bmp, 
gif, jpeg  кенгайтмали файларидан импорт қилинг (охирида (trace bitmap) 
ни бажариш эсдан чиқмасин). Биринчи кадрда расм билан матнларни 
биргаликда қўйиш ҳам имкониятлари мавжуд. Фақат шуни эсда тутиш 
керакки, биринчи ва охирги кадрларда гуруҳланган расмлар, белгилар  
бўлмаслиги керак, агарда гуруҳланган белгилар бўлса Break apart  ни 
бажаринг.  
 4 - қадам. Яна бир марта гуруҳлар ажратилганлигини текширинг – бу 
қуйидагича бажарилади. Расмга сичқонча билан чертинг –агарда  унинг 
атрофида квадрат пайдо бўлса, белгини ўзи ҳеч ажратилмаса – тезлик 
билан  ctrl+b тугмаларини босинг. Агарда расмлар биринчи ва охирги 
кадрларда “қoра рангли” бўлиб кўринса у ҳолда ҳаммаси жойида. 
5 - қадам. Биринчи кадрга икки марта сичқонча билан чертинг (ёки 
сичқончанинг ўнг томони – propеrties ёрдамида бажаринг). 
6 - қадам. Тwееning ни танланг. Менюдан  "Shape twening" буйруғини 
бажаринг.  
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7 - қадам. Distributive  опцияси доира шаклидаги расмларга қўл келади. 
Angular – ни эса бурчаклари, эгилишлари кўп бўлган расмлар учун 
қўлланилади. 

 
  Охирида тайёр анимацияни кўриш учун  Play (Ctrl-Еnter) 
тугмасини босилади. 
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